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What is a podcast? 
According to our good friend Wikipedia, a 
podcast is an “episodic series of spoken 
word digital audio files that a user can 
download to a personal device for easy 
listening”. 

Podcasts are a powerful communication 
tool, which have maintained popularity 
over the last few years. No longer a 
tool just for media savvy producers, 
many academics and higher education 
institutions have created their own 
podcasts to engage wider audiences with 
their work.

What are the benefits of creating a research-based podcast?
Creating a podcast which effectively communicates research and it’s importance relies 
on skills not usually well-practiced in academia. Although challenging, developing a 
podcast has many benefits. Not only can such projects help researchers strengthen 
their confidence and communication skills, but also their ability to:

• Identify and prioritise stakeholders

• Engage and expand networks

• Define objectives for public engagement and knowledge exchange activities

• Manage projects, resources and budgets

• Develop marketing plans

• Monitor and evaluate impact

Most importantly, a podcast can increase the visibility of King’s research and facilitate 
engagement and collaboration between our academics and wider society.

Before you start
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So what is this toolkit all about?
This is one of three guides which have been designed to show social science 
researchers* based at King’s College London, at any level, how they can use podcasts 
to disseminate their work.

One example we will keep returning to is Our Sick Society, a mental health podcast by 
the ESRC Centre for Society and Mental Health. This podcast was funded by the King’s 
Impact Acceleration Account, and was co-created by:

• a senior academic with experience of podcasting and radio broadcasting

• two early career researchers from the Centre

• an expert by experience

• a professional podcast producer 

• the Centre’s professional services team

The podcast project had three aims:

• To produce content shaped by experts by experience, hearing their voices as 
presenters and as well as interviewees

• Build the capacity of the early career researcher and expert by experience team 
members to communicate and engage stakeholders via podcasting 

• Share expertise developed throughout the project to the wider King’s community

This is one of three guides which have been written to address our final aim - 
the publication of a comprehensive toolkit to share expertise, tips and tricks for 
researchers interested in podcasting. The other guides cover:

• Leading a guest podcast episode 

• Being interviewed for a podcast

* academics in other fields may also find this toolkit helpful, but we use examples of content, stakeholders and 
topics drawn from social science research.

https://soundcloud.com/oursicksociety
https://www.kcl.ac.uk/csmh
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Section 1: Developing your idea

Create your team
You may want to jump straight into making your podcast, but it’s important to first 
think about the skills and expertise needed to get such a project up and running.

Many podcasts are a one-person affair - where someone has an idea, learns how to 
use the technology, and sets off to create the series alone. The advantages are obvious, 
it’s quick, easy to make decisions, and can work around their other commitments.  

Other podcasts are put together by a team, which is what we recommend you do. A 
team brings together lots of different perspectives and diverse voices, which can help 
to sense-check the approach to both the series and individual episodes.  

The expertise of your team members is very important. Regardless of how large it is, 
there are certain roles to fill. Including, but not limited to:

The Project Manager: Outlines and maintains the project 
plan. This includes episode schedules, deadlines, team 
availability, budget and resources. No mean feat when the 
podcast competes against the team’s other commitments!

The Branding Lead: Creates a consistent image and voice 
for the podcast. This can include guiding content, tone and 
guests included in each episode, as well as leading visual 
design to make the podcast immediately recognisable.  

The Producer: Ensures that content gets recorded and 
turned into an episode that people want to listen to! Includes 
oversight or delivery of recording and editing. These tasks 
require a degree of proficiency and experience. 
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You don’t want  a huge team, as that can become difficult to manage. However, it 
is useful to cover a range disciplines and expertise, both from academic roles and 
professional services. Members may join the team to achieve personal capacity 
building objectives, so consider how members can also learn from each other 
throughout the project. Other streams of support can be drawn from wider networks or 
contacts of the team. 

The Marketer: Gets episodes out into the world! Working on 
websites, advertising, social media and other channels to 
ensure that target audiences can find and engage with each 
episode and the wider brand.

One of the aims of Our Sick Society was to strengthen 
Centre communication activity and this influenced how we 
put together our team. Our producer and experienced host 
provided valuable support for the other team members.

The Host: The public representative of the podcast. Relies 
on interpersonal skills to put guests at ease and draw out 
information that the listener is interested in hearing. Ideally 
has experience of interviewing and is comfortable working 
with a people from a range of backgrounds.

Outline your theme 
The best podcasts have a specific theme or concept behind them, not only to inform 
episode development, but to hook audiences with a particular interest. For example:

• Serial, a famous and perhaps the original true crime podcast, is a serialised account 
of a real-life criminal investigation unfolding in real time, episode by episode

• Say Why to Drugs is an academic show examining the effects of drugs or an aspect 
of addiction in episodes which don’t have to be listened to in any particular order. 

https://serialpodcast.org/
https://play.acast.com/s/saywhytodrugs
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If you are developing a departmental podcast, you may want to align the theme to a 
particular strand of research or topic area. Here are some examples from across King’s:

• World: We Got This is produced by the School of Global Affairs. Each episode, the 
host discusses a particular global issue with academic experts

• A Podcast of One’s Own is produced by the Global Institute for Women’s Leadership. 
Each episode consists of conversations between Julia Gillard and prominent female 
leaders or experts on gender equality and leadership.

Outlining a niche for your podcast to occupy will help you communicate with your 
target audience more effectively. But first, we need to find out who they are... 

Identify your target audience
Different audiences are reached in different ways, so it is important to be clear about 
who you want to listen to your podcast. There is no such thing as “the general public” - 
society is more complicated than that!

As well as considering demographic data such as gender, age and ethnicity, you should 
also think about broader audience types. They may be similar to stakeholders you have 
already mapped for your research. Let’s look at some common target audiences for 
research-based podcasts and related communication tips:

• Academics: Likely to prefer a scholarly approach, with content relying heavily on 
theory and published work. They may also want to access resources referenced in 
your episodes, such as journal articles, via your website or social media pages.

• Individuals with lived 
experience of issues 
discussed: May prefer to listen 
to more informal content, 
with little academic jargon. 
It is wise to think about the 
position of the “academic 
expert” and how that sits with 
“expert by experience”. This is 
particularly important when 
dealing with controversial or 
complex topics. 

https://www.kcl.ac.uk/world-we-got-this
https://www.kcl.ac.uk/global-affairs
https://www.kcl.ac.uk/giwl/podcast
https://www.kcl.ac.uk/giwl/
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• Policy makers: Both local and national. They tend to like information in bite-sized 
chunks, and clear recommendations on what actions are needed. Aim to balance 
content between evidence and advocacy. For inspiration, look at briefing papers 
produced by your department or The Policy Institute.

• Students: Are likely listening to support their studies or career development. Think 
about how content could complement their learning and where to direct them for 
further information.

Some of your episodes may appeal to sub-groups of your target audiences. For 
example, students may be narrowed down to mental health or policy students. 
Whatever group your audience belongs to, consider tone and language, and how to 
make sometimes-complicated concepts more accessible. This doesn’t mean talking 
down to anyone, but it can mean taking a more creative approach, perhaps by including 
more experts by experience to illustrate topics with real world examples, or artistic 
elements such as music or spoken word.

Complete Task A on p14 to explore your target audience in more detail.

We recommend testing your ideas on a representative group of people - tell them what 
you are planning, ask if they would listen, and if they have any suggestions to make 
content more appealing or interesting. You can ask the King’s Engaged Researcher 
Network for advice on sourcing these groups if this proves challenging to arrange.

Explore how target audiences influence promotion in Section 7: Going live. 

Research your competitors
When planning your series, try listening to podcasts 
which cover similar content. This can help you to 
get a sense of how related topics are handled, how 
different formats are used, and how audiences 
engage with content. As well as looking at popular 
podcasting platforms (such as Soundcloud or 
Acast), for more specialist topics, find organisations 
releasing their own independent podcasts. 

https://www.kcl.ac.uk/policy-institute/research-analysis
https://kingsengagedresearchblog.wordpress.com/contact/
https://kingsengagedresearchblog.wordpress.com/contact/
https://soundcloud.com/
https://www.acast.com/
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For example:

• The Royal College of Psychiatrists

• The Mental Health Foundation

Think about what makes these podcasts so successful. Could it be a popular host, 
famous guests, coverage of key topics and current affairs, or perhaps just effective 
marketing? Reviews can also give insight into how the audience responds to content. 

What can you learn from reviews for the BBC All in the Mind podcast ?

Don’t forget that competitors could also become collaborators! Try getting in touch with 
established podcasts, particularly those within King’s, to see if there are opportunities 
to work together on future episodes.

Complete Task B on p15 to identify your competitors.

Outline your objectives
Now it’s time to prepare a list of objectives. This is the most important part of project 
planning, as you outline exactly what you want the podcast to actually do. Inform, 
entertain, enlighten, change hearts and minds, provoke curiosity, be controversial? All 
are valid - you may want to do all of the 
above and more! However, the purpose 
of your objectives is to direct the project 
and help you evaluate success.

You could aim for a certain number of 
listeners or downloads, but are there any 
concrete outcomes (other than episode 
delivery) you want to achieve? 

As with all objective setting exercises, 
make sure you think SMART – are they: 

https://www.rcpsych.ac.uk/news-and-features/podcasts/detail/you-are-not-alone%E2%80%93episode-1-doctors-with-mental-illness
https://soundcloud.com/mentalhealthfoundation
https://podcasts.apple.com/gb/podcast/all-in-the-mind/id643660675#see-all/reviews
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• Specific: includes a clear and narrow description of your objective

• Measurable: outlines metrics to track and evaluate success

• Achievable: realistic and motivating, not overly ambitious and off-putting

• Relevant: contributes to your wider project goals and purpose

• Time-bound: uses deadlines and milestones for reflection and learning

Your team may have personal objectives, such as skills development or ways to apply 
learning to their work. Try to embed these into your project plan.

Here are two objectives from Our Sick Society:
• Each host to apply training to deliver 2 episodes each
• To achieve 1000 listens by the end of August 2021

See Section 8: Evaluating success for more information.

Consider your brand
Your brand refers to the way that the podcast will be perceived by your audience. 
It encapsulates what the podcast is about, what you represent, your tone and your 
approach. A consistent brand will help you connect to your target audiences. 

To give shape to your brand, list your core values, and make sure these are considered 
or referred to throughout the podcast. Identifying a Unique Selling Point (USP) - 
something which makes your podcast stand out - can help with this process.

It is helpful to create a boilerplate - a short block of text, usually just a paragraph, which 
can be used for marketing and communication purposes. It should cover what the 
podcast is about, who takes part, and what the show aims to achieve. 

Complete Task C on p16 to set your SMART objectives.
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Boilerplates can be added to your podcasting platform page, website, or departmental 
newsletters, or just kept on hand if someone asks for more information! 

Identify key contributors
Now you have identified your themes, audience, and objectives, we now need to find 
contributors! Contributors can take part as guests or as hosts. Are there particular 
groups which need representing or individuals whose expertise aligns to your theme? 

Let’s say, for example, that you are making a podcast about children’s mental health. 
You may want to hear from:

• Experts by experience: Children and families 
themselves!

• Researchers: Those exploring child mental 
health or related topics.

• Political figures: The Children’s Commissioner 
or Minister for Children and Families.

• Charity sector: Children’s charity staff or local 
youth groups.

Don’t forget other sectors such as healthcare, business and technology.

Having a broad list can help you plan episodes more effectively - but do be realistic! 
Securing high-profile speakers usually requires an intermediary contact and can take 
some time.

Review need for funding
It is possible to make a podcast series for very little money. However, there are lots of 
hidden costs, such as:

• Staff / guest time and expenses

• Equipment purchase or hire

• Music licenses 

• Analytical / marketing software
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Many funders, including King’s, offer grants for public 
engagement: 

• King’s ESRC Impact Acceleration Account

• King’s Cultural Community Small Grants Fund

• Wellcome Public Engagement funding

You might even find that your department gets behind your idea and are able to fund 
your podcast. Don’t be afraid to ask!

We go into detail about guest payment in Section 4: Pre-Production.

Complete Task D on p17 to start outlining your budget.

Scope out the whole series
At this stage, decide how many episodes you want to produce, and whether to run 
continuously or in seasons. Be ambitious, but don’t over-reach your team to the point 
that you can’t deliver! Consider:

• Which topics will be covered by each episode 

• How topics fit together under your theme

• The order and grouping of episodes 

• How frequently will they will be released

Aiming to release one episode a month for the first few months will build momentum, 
both in terms of your workload and in obtaining listeners. We recommend allowing two 
or three months to get the first few episodes in the bag before launch. This gives your 
team time to listen, reflect, discuss and improve, without pressure of public response.

Complete Task E on p18 to prepare your workplan.

https://www.kcl.ac.uk/research/funding-opportunities/impact-acceleration/esrc-impact-acceleration-account
https://www.kcl.ac.uk/cultural/connecting/small-grants-scheme
https://wellcome.org/grant-funding/schemes?f%5B0%5D=funding_area_funding_schemes%3A8701
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• How old are they?

• Where do they live?

• Do they have a family?

• What other relationships do they have?

• What topics are they interested in?

• What hobbies do they enjoy?

• What public figures do they admire?

• Who do they trust?

• Who don’t they trust?

• What are their achievements? 

• What challenges are they 
experiencing?

• What job do they do?

• Who do they work with?

• What networks or groups do they 
belong to?

• What social media accounts do they 
use?

• What other podcasts do they listen to?

• How did they find your podcast?

• Why do they listen to the podcast?

• Why would they subscribe?

• When do they listen to the podcast?

• What do they do with things they learn 
from each episode?

• Who do they share the podcast with?

• How do they find out more information 
about topics discussed on the 
podcast?

A: Identify your perfect listener

This activity will help you create an avatar of your perfect listener. This will help you 
explore your target audience in more detail, and consider how to engage them. When 
planning episodes, refer back to your avatar and think about how they would react or 
engage to proposed content.

Section 1: Developing your idea
Tools and Resources

https://blog.spreaker.com/how-to-create-the-perfect-podcast-avatar/
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B: Identify your competitors

Find three podcasts that focus on topics or themes you would like to explore with your 
own podcast. Answer the following questions for each of them:

• Who hosts the podcast?

• What types of guests do they have?

• Do they interact with the guests 
directly? 

• Are the guests young or old?

• Are the guests predominantly 
representative of one group (e.g. an 
academic field, mostly male guests, 
mostly London based) or more 
diverse?

• What format do they use?

• Is the tone formal or informal?

• Is the language very technical or easy 
to understand?

• What topics do they cover?

• What geographic location do they 
cover?

• Can you identify their target audience?

• Do they speak to the audience directly?

• Do they ask the audience to interact in 
someway?

• Do they direct the audience to other 
resources (e.g. websites, Facebook 
groups etc)?

• Is the audio clear and consistent?

• Is the branding professional?

• Can you identify their possible 
objectives?

• How many episodes do they have?

• Do the episodes link together in some 
way?

• Is the podcast broken down into 
seasons?

• How often are episodes released?

• Are there any reviews? What do they 
say?

• What do you like about the podcast 
and why?

• What don’t you like about the podcast 
and why?

• How is your planned podcast different 
to this one?
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C: Set your SMART objectives 

Complete the below activity to identify SMART objectives for your podcast.

SPECIFIC 
Should include 
an answer to 
“who, what, when, 
where or why”

MEASURABLE 
How will you 
determine 
success? Use 
metrics and / or 
deadlines.

ACHIEVABLE 
How will you 
make this 
happen? What 
skills / support 
will you need?

RELEVANT 
How does 
this objective 
contribute to your 
overarching goals 
for the podcast?

TIME-BOUND 
When will 
this objective 
be achieved? 
What are your 
deadlines?
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D: Budget 

Which of the following items will you need to include in your budget? 

• Staff time for your team members

• Guest speaker fees

• Transport costs (team and guests)

• Catering (for long recordings)

• Microphones

• Headsets

• Invoice processing fees 

• Editing software / apps

• Venue hire

• Recording studio hire

• Platform licenses

• Social media analytical software

• Intro, outro, background music 
licenses

Click here to view and download the OSS Podcast Budget Template.

https://docs.google.com/spreadsheets/d/1Qa8WXZIgZWMpB70M8dnx2utQbTpFdOg6/edit?usp=sharing&ouid=116843889388853059855&rtpof=true&sd=true
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E: Prepare your workplan 

Answer the questions below to inform a workplan for your podcast. We recommend 
using a Gantt Chart or similar project management tool.

• How many episodes are you planning?

• How often will they be released?

• How long will it take to secure guests 
and a recording space for each 
episode?

• How long does it take to record each 
episode?

• How much time will you give for 
guests to provide consent?

• How long will it take to provide 
transcripts and a paper edit for each 
episode?

• How long does it take to send content 
to whoever is editing the episode?

• How long will they take to put the 
episode together?

• When will the team have time to 
review the episode?

• How long will it take to carry out final 
edits?

• How long will it take to upload the 
podcast?

• How much lead time does the 
marketing lead need to develop 
content?

• How much notice do you need to give 
guests before the episode is released? 

• Will you give them time to listen to the 
episode first?

• How much time will your team spend 
on marketing and promotions?

• Will you be able to make multiple 
episodes at the same time?

• Where are the pressure points for 
team members over the course of the 
project?

• How long will it take to process 
payments for guests or resources?

• When will you schedule team 
meetings?

• What information do you need to 
review progress in meeting your 
objectives?

• Does your funder have specific 
deadlines for expenditure or reporting?

https://support.microsoft.com/en-us/office/work-with-the-gantt-chart-view-0e84efa4-78ce-4cd1-baed-5159a55f78b4
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Section 2: Planning episodes

This section has been written for podcast series producers. If you 
have guest hosts for single episodes, or are developing a one-
off episode for an established series, refer to our other guide:  
Leading a guest podcast episode.

Once the wider podcast series has been outlined, it’s time to plan your episodes. 

Telling the story
Every episode should be designed to tell a story to the audience. As with any good 
story, you’ll need to include some key components: 

A clear and relatable setting
When planning each episode, ask yourself:

• What is the episode about? What topic(s) will it explore?

• How does this episode relate or contribute to the podcast theme?

• What are the key questions it will ask and hopefully answer? 

• Will the target audience find it interesting?

Keep in mind that the shape and direction of your episode could change as recordings 
take place. New topics or angles could arise, resulting in a shift of focus. 

A varied cast of characters
This refers to both the host and your guests. Who can help you explore topics, answer 
questions, and most importantly, make 
content interesting and relevant for our 
target audience?

As a rule, academics can talk about 
research and evidence, but to make that 
evidence come alive you might have to 
include those with lived experience.
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Create a long list of possible guests. See if your team members have contacts who 
would like to put themselves or others forward. You can also reach out to your 
department or internal networks to find participants, such as the King’s Engaged 
Researcher Network or King’s & London. 

Review your list and consider:

• Are there balanced views?

• Are your guests diverse and representative?

• Are you taking an interdisciplinary approach to finding your answers? 

You may be familiar with the work of preferred guests, but it is helpful to do some 
background research to determine if they will make a good guest. Find examples of:

• Public speaking: can they engage audiences, ideally non-academic, with their 
work? Does their speaking tone and style fit with your podcast?

• Media articles or blogs: have they written for, or been quoted by, non-academic 
media? How do they come across?

• Their own websites or social media accounts: what content do they share? How is 
content presented? Do they already have an audience for their work?

There is a fine line between background research and stalking, so do stick to 
professional profiles! However, keep in mind that listeners may do their own research 
after listening to the episode. It is good to be aware of things, positive and negative, 
that they might find.

Remember that not everyone from your list will be able to make time during your 
recording window, and others may drop out at the last minute. Have some back-ups!

An easy to follow format
You have several formats to choose from to 
help you tell the story. You should choose the 
most appropriate one for each episode, as the 
format will affect who you ask to contribute 
to the discussion, and how. Let’s look at pros, 
cons and examples of different formats.

https://kingsengagedresearchblog.wordpress.com/
https://kingsengagedresearchblog.wordpress.com/
https://www.kcl.ac.uk/london
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Roundtable 
Not dissimilar to panel discussions. When a group of people discuss a topic, with a 
chairperson (likely your host) to keep everyone on track. 

Relatively easy to set up once you have found a time that suits everyone
Quick to record
Guests tend to bounce off each other, with conversation bringing new insight

Guests may talk over each other, which  could become distracting 
Timeframe can easily over-run or go off-track
Can be difficult to edit without interrupting the flow

Our Sick Society: Race, Employment and Health

Documentary style
A series of interviews with different people, edited together with a presenter links. 

Fast-moving storytelling with lots of different voices
Creates a varied listening experience in terms of pace, tone and content

Relies on effective interview skills and creativity to bring episode together
Very time consuming - for recording, transcription and editing

Our Sick Society: Covid-19, Quarantine and Community

In conversation with 
AKA the “interview format” where the host(s) leads a conversation with guests. 

Quick and relatively easy to set up and record
Very naturalistic and easy to listen to (when it goes well!) 
 
Relies on what people say, how they say it, and the relationship between them. 
If conversation gets stilted, goes off topic, or becomes long-winded, it can be 
difficult to edit without interrupting the flow of the episode

Our Sick Society: Recovery and Lockdown

There is a worked example of this format in Section 6: Post-production.

https://soundcloud.com/oursicksociety/episode-2
https://soundcloud.com/oursicksociety/episode-1
https://soundcloud.com/oursicksociety/recovery-and-lockdown
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Sometimes a roundtable-style episode is recorded as part of an event in front of a live 
audience – this requires the host to consider all the aspects of a live event AND the 
podcast episode. It can get complicated, but an effective chair should be able to make 
a pretty good job of hosting a roundtable format.  

Solo monologue
The listener only hears from one host who tells the story, no guests. More experienced 
and/or instinctive podcasters might choose a solo monologue format. This format is not 
for the faint hearted, but when it works, it can be very, very effective.

It’s easy! The team only has to rely on one person.
Creates a bond with your listeners – you are speaking directly to them. 

Requires a lot of talking!
The host needs to find a balance between being scripted and sounding natural. 

The Moth: Planting Roots by Andrew Mude

Co-host 
Where two or more hosts discuss something together, but as co-presenters rather 
than interviewee and interviewer.  

Popular with many listeners 
Easy to listen to, particularly when the hosts have rapport

Requires some scripting, even rehearsal, for longer episodes
Relies on good scheduling over a long period, if repeating for a whole series

Say Why To Drugs: Psychedelics

Don’t be afraid of making the wrong choice, or of mixing formats up a bit. The process 
of making a podcast is a learning experience, and much of that learning will take place 
as you go along. Remember, nothing is set in stone. Yes, there is received wisdom 
about what works and what doesn’t, but rules are there to be broken!

An interesting and well-paced plot
Once you have decided on your format, it is helpful to outline how content will flow 
together to present your story. Many podcasts will divide their content into three: 

• Part 1: Setting the scene, laying groundwork about why the topic is important

https://themoth.org/podcast/andrew-mude-planting-roots
https://play.acast.com/s/saywhytodrugs/psychedelics
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• Part 2: Asking and answering key questions, presenting a ‘conflict’ to overcome 
(e.g. contrasting views, a specific challenge or aspect of the topic - something to tie 
content together and move the story along).

• Part 3: Drawing together answers and making conclusions. 

How you edit content together will depend on the length of your episodes. For 
example, if you want your episodes to last 30 minutes, and you interview 5 people, by 
the time you include an introduction, closing credits, and presenter links, you are only 
giving guests 3 – 5 minutes of content each, which may be cut up across the episode. 

The average length of a podcast is around 45 minutes but can range anywhere 
between 25 – 90 minutes. It’s good to be consistent across all the podcast series, to 
help the listener know what to expect when they subscribe. 

An impactful ending
Use your ending to invite the listener to reflect on content discussed in the episode, 
and how it relates to them. 

Depending on the topics or content shared, you may also want to include a call to 
action for your audience when you close each episode. This could include:

• Where to find information about about your work and 
that of your guests

• Where to find related content (e.g. papers or books)

• Sources of support for those affected by content

• A request to leave a review or subscribe

Make sure you allocate enough time for content at the end 
of each episode, and have a think about where information 
could sit so that it is accessible for all audiences.

You may want include a teaser for the next / related episode, 
to entice listeners to return and subscribe!

Complete Task F on p24 to outline an episode.
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Section 2: Planning episodes
Tools and Resources

F: Episode outline
Use this template to plan each episode.

Working title

Topic(s)

Links to podcast 
theme 

Links to other 
episodes

Key questions

Host

Guests

Format

Basic structure
Setting the scene - why is this topic important? Who leads?

Key questions - what is the order? Who asks/answers?

Conclusions - who does this? Key takeaways? What next?

Calls to action
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Section 3: Equipment

One of the most important overriding parts of a podcast is the concept behind it. It’s 
an idea that comes from music production – you can have a song which is produced 
in the most deluxe studio imaginable, with lots of fancy top-of-the-range equipment, 
but if the song itself isn’t working, then there isn’t much that the equipment can 
do to fix this. While nice to keep in mind, it is preferable to use the highest quality 
equipment available. This certainly doesn’t mean spending lots of money, but it helps 
to understand what you need and why. 

Basic concepts
A podcast is, essentially, a series of recorded voices which are chopped and edited 
together. We therefore need equipment to help us:

• Record each voice 

• Edit and balance / equalize each voice

• Stitch all the voices together, along with any music, to form the episode

Let’s first look at some basic concepts to help us with these steps.

Lossless vs Lossy Audio  
When recording, it’s best to begin with a high-quality audio file, such as:

• .wav

• .aiff

• .flac

These are often referred to as ‘lossless’ files, which means what it says – they retain 
as much information as they’ve received via the microphone - no information is lost or 
compressed for the sake of file size. Audio tends to be crisp and of higher quality.

This section talks about two different products called Zoom. 
Zoom (R) refers to the Zoom recording devices, while Zoom (S) 
refers to the video-conferencing software.

https://zoomcorp.com/en/gb/
https://zoom.us/
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An .mp3 file, which you will usually end up with when recording on your phone 
or laptop, or via software such as Zoom (S) is known as ‘lossy’ - files which are 
compressed and shrunk down, resulting in loss of quality and a smaller file size. These 
files can be difficult to edit and balance, and therefore hard to listen to. 

A good, solid setting for your recording is 48k / 24bit – you should be able to find this 
option in the device or software settings. For reference, this setting is slightly higher 
than CD quality (44.1k) and will record more sound information into your file. You can 
get away with recording to 320k .mp3 file if needed, for example if you don’t have 
much room on a memory card or are using Zoom (S), but it’s always best to go higher if 
possible. You can’t upgrade a file from lossy to lossless after recording!

Individual audio tracks 
Always record each voice on a separate audio track, regardless of whether you 
are recording remotely or in-person. We’ll go into more detail in Section 6: Post-
Production, but essentially, individual tracks help the editor to separately balance and 
equalize each voice (i.e. adjust volume and clarity). This makes it easier to edit out:

• Coughs or clearing throats

• Rustling of papers or clothing

• Background noise

• Echoes or connectivity blips

• Interruptions or repetitions

If you’re using Zoom (S) software to record, this setting is found in Settings > 
Recording and by clicking the ‘record separate files’ box. Remember to save recordings 
onto the computer and not the cloud. This isn’t obvious and has only revealed itself 
through a few failed recordings over time, but the separate tracks can only be obtained 
if recording to the computer - not via a phone or iPads. 

Section 5: Production has more tips on obtaining well-synced audio files.

Recording devices
It’s often said that you can make a podcast on a phone. While this is definitely true, 

https://support.zoom.us/hc/en-us/articles/201362473-Local-recording
https://support.zoom.us/hc/en-us/articles/201362473-Local-recording
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we don’t recommend you use phones or built-in laptop microphones as your primary 
recording device. This is because the overall quality is often low, and you will almost 
always pick up background noises such as taps, clicks and whirring fans. Phone 
recording apps can be used as a backup, but it is best to use specialist equipment.

Microphones 
If recording in person, table-top microphones are better than lapel mics, as they are 
fixed and won’t pick up noise when the guest fidgets. Your microphones should be 
neatly arranged on a table close to the speaker’s mouth. Tuck any cables away so they 
don’t distract or disrupt the person speaking. You may need a pop cover, something 
that softens the audio if the room is not adequately sound-proofed, and muffles pops 
and plosives when someone is talking, making the audio more pleasing to the ear! 

For outside recordings, your microphone should ideally be battery powered so it is 
more mobile. You may need to buy a wind muff for your microphone. These act the 
same as a pop cover, and will improve sound quality by blocking wind as well as pops 
and plosives. You may also need a boom arm or stand, to hold the microphone at a 
distance. Check product websites for accompanying accessories. 

For remote recordings, ask your guests to use earphones with microphones or 
a headset. There are lots of options online if you need to provide one for them. 
Sennheiser or Jabra are good brands which have products in a variety of price ranges.

Model Description Price

Sennheiser SC30 USB Individual headset for virtual recordings. £20 - £25

Jabra Evolve 20 USB Individual headset for virtual recordings. £50

Blue Snowball ICE Desktop microphone for in-person recordings. 
Higher quality budget option. Includes stand.

£59

Shure SM58 Popular all-rounder microphone for in-person 
recordings. Can be handheld, or used in a stand.

£99

Shure SM57 More compact all-rounder mic for in-person 
recordings. Handheld, or used in a stand. £99

Blue Yeti Simple USB plug-in mic. Designed for 
podcasting. Includes stand.

£119

https://business.currys.co.uk/catalogue/office-supplies/phones-faxes/headsets/sennheiser-sc-30-usb-ml-headset/P155737P?cidp=Froogle&gclid=Cj0KCQjwqp-LBhDQARIsAO0a6aKHUWjHz1mBmPC1lhg8fTjl_6oU2SXFCq78sHrilD64MqL5Zt3LzZQaAgUIEALw_wcB&gclsrc=aw.ds
https://www.johnlewis.com/jabra-evolve-20-noise-cancelling-on-ear-usb-headphones-with-mic-headset/p4973069?sku=238682180&
https://www.bluemic.com/en-gb/products/snowball-ice/
https://www.shure.com/en-GB/products/microphones/sm58
https://www.shure.com/en-GB/products/microphones/sm57
https://www.bluemic.com/en-gb/products/yeti/
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Costs can add up if you have lots of speakers in one room, and it may not be cost 
effective to buy lots of microphones unless you do this often. Speak to your department 
or the King’s Audio-Visual department about equipment hire instead. 

Specialist recorders 
Zooms (R) are specialised recorders commonly used by podcasters, including the 
Our Sick Society team. These are more sophisticated than a standard microphone, 
recording high quality audio tracks (voices) via a handheld device. Zooms (R) can be 
used as computer audio interfaces, allowing you to record straight to your computer. 
They come in a range of models, which vary in cost and performance. Alternatively, 
King’s Audio Visual have a similar model, the Tascam DR-40 available for hire.

Model Tracks Description Cost King’s Hire

Tascam 
DR-40

4 Variety of export and recording 
modes

£100 - £150 Yes

Zoom H4N 2 On board mics for indoor and 
outdoor recording

£195 - £210 Yes

Zoom H6 4 As above, plus back-up option in 
event of power failure

£300 - £320
No

Check with AV or your department to see what insurance is 
required when taking equipment outside of King’s campuses.

Software
If you choose to record remotely, we recommend using Zoom (S) because, as 
previously mentioned, it will give you separate audio tracks for each device on the call.  
However, Zoom audio will always be processed into an .mp3 file, so the quality will be 
quite low. 

There are lots of podcast editing platforms available, with different features and prices. 
To make a good podcast, you want your software to chop up audio tracks, stablise and 
equalize your voices, and stitch together your all the edited tracks, ideally alongside 
some music, to create your episode. Here are some popular options to get you started: 

https://tascam.com/us/product/dr-40/top
https://tascam.com/us/product/dr-40/top
https://zoomcorp.com/en/gb/handheld-recorders/handheld-recorders/h4n-pro/
https://zoomcorp.com/en/gb/handheld-recorders/handheld-recorders/h6-audio-recorder/
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Model Description Cost

Audacity Popular and easy to use software for podcast editing Free

Garageband Predominantly for music, but basic and easy to use 
platform for audio editing. Mac only.

Free

Adobe Audition More sophisticated and comprehensive platform for 
audio editing. 

From £20 
per month

Do be mindful that there are some limitations on subscriptions you can pay for using 
King’s payment cards and/or expenses claims.

Support at King’s
There is a range of audio visual support for the recording of your podcast: 

• King’s AV booking

• King’s AV Podcasting equipment guide 

• King’s Podcast Producers (Teams)

Complete Task G on p30 to review your equipment needs.

We explore how to use Audacity to edit your podcast episodes in Section 
6: Post-Production

https://www.audacityteam.org/
https://www.apple.com/uk/mac/garageband/
https://www.adobe.com/uk/products/audition.html?mv=search&mv=search&sdid=MC95SLNN&ef_id=CjwKCAjwh5qLBhALEiwAioods1IpJvsK7g917XEaEMIC2k1f74VAuHmZfR_BpXE24kWJ8CKJ6EghOhoCTiYQAvD_BwE:G:s&s_kwcid=AL!3085!3!340721684816!e!!g!!adobe%20audition!1422700010!54632149663&gclid=CjwKCAjwh5qLBhALEiwAioods1IpJvsK7g917XEaEMIC2k1f74VAuHmZfR_BpXE24kWJ8CKJ6EghOhoCTiYQAvD_BwE
https://internal.kcl.ac.uk/it/av/index
https://internal.kcl.ac.uk/it/AssetsFiles/AVHelp/podcasting.pdf
mailto:csmh%40kcl.ac.uk?subject=Introduction%20to%20the%20King%27s%20Podcast%20Producers%20Team
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Section 3: Equipment
Tools and Resources

G: Equipment checklist
Use these templates to decide what equipment is needed.

In-person recordings

Location

Recording device

Number of guests (i.e. number of microphones)

If outdoors Wind muff

Boom arm / stand

If indoors
Pop cover

Microphone stands

Lapel mics
Transport / storage

Virtual recordings

Software

Location
(If room booking is required at King’s)

Number of guests 

Host
Pop cover

Microphone 

Microphone stand
Guests Headsets

Microphone / Stand

Transport / storage
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Section 4: Pre-Production

Sourcing interviewees
Prioritise your list of guests and create a shortlist for your episode. 

If possible, arrange an initial phone conversation between each person and your 
producer or host. This could be tricky to arrange, but useful in a couple of ways: If 
you are confident they’ll be a great guest, you could use this call to tell them more 
about the episode and invite them to take part outright. But if you want to sound 
them out first, to see how well they can talk about their work or experience, you could 
instead invite them to provide some “background information” for the episode you are 
developing before asking them to be interviewed on the show. 

Paying for their time
For those you do invite to take part, make sure you discuss any speaking fees or 
expenses. If you have a tight budget, you may need to discuss this before you confirm 
their participation, as they could be outside of your price range. 

High-profile speakers will likely have set rates for their time, and experts by experience 
will need time and expenses covered. There are special considerations for paying those 
who receive income-related employment and support allowances. Here are some 
helpful resources to look at:

• ESA and Getting Paid for Service User Involvement by Judy Scott

• Paying people who receive benefits - Co-production and involvement by SCIE

• Co-creating our payment policy: a personal reflection by Co-Production Collective

These conversations may be difficult, so please do reach out to your department or the 
Centre for Society and Mental Health for support if required.

Agreeing a location 
In-person recording
If it is safe to do so, you might conduct the interview in person. Secure an appropriate 
location for an audio interview – it may sound obvious, but open-plan offices, noisy 
cafés, or busy outside areas are not ideal! There may be rooms available across King’s. 

Locations are not only functional, but can allow you to add colour and texture to your 
episode. For example, if you are exploring the value of nature for good mental health, 

https://judyscottconsult.com/publications/
https://www.scie.org.uk/co-production/supporting/paying-people-who-receive-benefits
https://www.coproductioncollective.co.uk/news/co-creating-our-payment-policy-a-personal-reflection
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recording outside with birdsong or rustling leaves helps you make a point in a way 
which is not only effective but beautiful to listen to. There may be sounds you can 
record on location which will add to understanding in a way that words simply can’t - 
things like traffic noise, sirens blaring, busy crowd noise, or machine beeps and whirrs. 
This audio can be used as background “music” or as transitions between segments of 
your episode.

A location can be used as an explicit part of your story. For example, if the host is 
travelling via train to an interview, they could record something like: 

Host: I’m sitting on a train to County Durham, to the only place in the country where 
this project happens. I’m excited to meet Joe Bloggs, who set this organisation up, 
and to find out why the North East makes such a good location for this project. 

Location is an important consideration when making 
your guest feel comfortable. You can record in their 
places of work, indoors, outdoors, private spaces, 
public spaces – each location will influence how the 
interviewee feels. Some locations may be triggering or 
uncomfortable for your guest, for example hospitals or 
clinical settings. This will of course affect the interview 
tone, and possibly content too. 

You must be cautious about entering other people’s 
homes or spaces which require special supervision, 
such as schools. Accessibility should also be a key 
consideration when selecting a location. 

If you are recording outside, you may need some special equipment. See 
Section 3: Equipment for more information.

Remote recording
The Covid-19 pandemic has meant that most people are now comfortable with video 
calling, and it may be better to record remotely. This can save both time and money.

Pick a platform which both you and the guest are comfortable using - although we 
recommend Zoom (S) due to it’s recording functionality. 
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It is very helpful to know which device they will 
use to join the recording. Remember, interviewees 
won’t necessarily be using a computer, they may 
be using a phone or a tablet. Some may have 
accessibility needs or require special equipment. 

Find out early, so you can determine if additional 
preparation or tech support is needed. Bringing the guest into this process can build 
trust and instill a touch of confidence, particularly when their needs and preferences 
are catered for. 

It is good practice to set up a test run to gauge the guest’s comfort with the platform, 
as well as the audio and internet quality and equipment needs. Do this at least a week 
before the actual recording, to allow time for changes or delivery of equipment.

Prepping the host and guests  
Your host will need to prepare some interview questions – not only the key questions, 
but follow-up ones to probe deeper, or steer discussion if the guest goes off-track. 

Some guests may ask for questions in advance, but this runs the risk of them preparing 
or rehearsing answers, which will sound unnatural and stilted in the recording. Instead, 
send them a broad list of topics you’d like to cover, and remind them:

• What the wider episode will look like (length, structure, format) 

• What you’ll be looking to explore with them

• Why you wanted them specifically to take part

• Who else has been confirmed to take part  

• What will happen after recording

This is a good time to ask them if they have any resources to plug (such as a paper or 
book) and details of any social media channels or websites to include in promotions.

Who should be at the recording?  
We recommend having at least two team members present during the recording - one 
as host and the other as a producer. It is very difficult to interview and record at the 
same time, and it can be distracting for the guest if the host is not 100% attentive.
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Some topics are difficult to talk about, and guests may become distressed or need 
some support. Make sure that every guest is aware that they can have another person 
present when recording. If you are interviewing someone who is vulnerable, or under 
the age of 18, a parent, guardian or support person must always be present. 

You should also think about who shouldn’t be at the recording. When guests are being 
asked to discuss sensitive or difficult subjects, they may feel uncomfortable having 
unfamiliar, or too many, people, joining the recording. Where possible, limit numbers 
and have production support on hand but hidden (this is easier when virtual rather 
than face-to-face). If this is not possible, brief and reassure your guests ahead of time. 

Consent and risk
Before releasing a podcast, you will need to obtain consent 
from your guests. A consent form provides permission for 
King’s to use recorded audio both within the episode and 
in any marketing. It also provides clear instructions for 
the guest to restrict (i.e. anonymise) or withdraw consent. 
Here is some light-touch guidance on obtaining consent 
for different types of guests:

• King’s employees: Consent is captured in their employment contract. However it is 
good practice to provide them with a written outline of how their data will be used 
and how to restrict or withdraw consent. Do this in an email, as you will need to file 
their acknowledgement of receiving this information somewhere safe.

• External to King’s: you will need to send them a form which is approved by your 
department. Some may need to seek permission from their employer.

• Under-18’s and vulnerable adults: you will need to seek permission from a parent 
or guardian. 

Click here for more information about consent forms. Speak to your department lead 
for more information, or email csmh@kcl.ac.uk to view our consent forms.

Always carry out a risk assessment for each recording, regardless of the guest or 
location. This is important if you are interviewing someone who could be deemed 
vulnerable, or to whom you have a duty of care.

Complete Tasks H and I on page 35 to run through guest checklists.

https://internal.kcl.ac.uk/erd/depts/brand-and-marketing-portal/digital-content/consent-for-photography-and-videos
mailto:csmh%40kcl.ac.uk?subject=Consent%20forms
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Section 4: Pre-Production
Tools and Resources

H: Guest pre-confirmation checklist
Ensure you tick off all of these key items before confirming your guest:

Podcast and episode information and links shared

Fees discussed, negotiated (if required) and agreed 

Recording window provided and availability confirmed 

Consent form shared

I: Guest post-confirmation checklist
Ensure you tick off all of these key items after confirming your guest, but before 
recording takes place

Recording date, time and location confirmed

Consent form deadline confirmed 

(if virtual) Equipment test scheduled

Accessibility requirements confirmed and planned for

Travel booked (if required)

Expenses forms shared

Guest resources / communication details for promotion

Episode information shared (Length, structure, format; Broad theme; Topics 
you want to discuss with them; Other guests)

Post-production process shared 
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It’s time to record! This bit of the process is known as 
production. The following advice applies whether you 
are recording in-person or remotely.

Managing the recordings 
As discussed, we recommend having at least two 
of your team present during recording. One to act as 
host, and the other as producer. The latter will manage 
the technology and equipment, while host focuses all 
their attention on the guest.

Record your basic assets
Before you record your episodes, begin gathering basic assets for the series. This 
includes an intro and outro for each episode, and a trailer for the series.

Intro and Outros
Each episode should have a consistent opening and closing. Not only does this signal 
the beginning and end of each episode, but it also makes the podcast sound more 
professional! A good intro will usually consistent of some theme music, a description of 
the podcast including theme and objectives, and a listener welcome from the host(s). 

An outro can be used to thank the guests, departments or funders, as well as to 
instruct the listener - for example to look up resources, or review and subscribe. You 
could record these individually for each episode, but we recommend creating files 
which can be reused throughout the series.

Trailer
A trailer is a great asset for promoting your podcast. You can release this early as a 
little teaser for what the podcast will cover. You could also ask other podcasts in the 
King’s network, to play it in breaks of their episodes to help generate interest. 

A trailer should be short - between 1 - 2 minutes -  and should explain what the podcast 
is about, why people should listen and give a taste of the podcast style and brand. 

Section 5: Production

Click here to listen to the Our Sick Society trailer.

https://soundcloud.com/oursicksociety/our-sick-society-trailer
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Initial checks
Consent reminder
Before you record, make sure you have the relevant consent forms signed! You could 
obtain these after the recording, however it is better to get them up front to save time 
in post-production. Run through the form to remind your guest about the recording 
process, and their rights to withdraw or restrict consent ahead of episode release.

Test equipment
Ask your guest to say something to check that your devices are recording properly 
and at the right levels. A good question for this is “tell me what you had for breakfast”, 
which can also act as a bit of an icebreaker! Some voices can be difficult to listen to 
– they may be very soft, very loud or very high. Responses to this question help you 
tweak the volume or microphone position to improve audio.

Recording requirements
Before you start recording, ask both your host and your guests to:

• Speak directly into the microphone but 
try not to touch it

• Remove noisy jewellery or items from 
the table / immediate area

• If referring to notes, lay them out on 
the table and try not to touch them. If 
there is no table, shuffle as far away 
from the microphone as possible

• If recording remotely, do not mute the 
microphone at any time. This “pauses” 
the audio track meaning that it will be 
out of sync with other tracks recorded 
during the call.

Check-in with your guest
All guests are different, and their recording personas might surprise you. There are 
people who are very eloquent and engaging speakers, but clam up when a microphone 
is put in front of them. Many interviewees are nervous about taking part in a podcast - 
they may not have done it before, or they may not like the sound of their own voices or 
be worried about saying something inappropriate. 
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If you pick up on any of these things, it’s important to reassure your interviewee 
before you start recording. Emphasise the fact that it will feel like being in a normal 
conversation, and that they have control over what is used in the final edit. 

It’s also very good practice to manage their expectations, particuarly if you spend an 
hour interviewing someone but only end up using 30 seconds of their interview! Let 
them know how much content will likely be used. Most will understand that you are 
trying to tell a story, and that their answers will form only one part of that story.    

Complete Task J on p46 for your pre-record checks.

Recording begins
After you hit record, continue informal conversation before launching into the 
questions. Encourage them to pause and think about responses, as silences are easily 
edited out post-production! If they don’t like what they say, they can always try again. 

Get your guest to introduce themselves, saying their name and one line of quick 
description as to who they are (this should also sum up what makes them relevant for 
the podcast). Give them some guidance on the audience and how much (or how little) 
information is needed. For example...

Guest: My name is Sarah Whoever, and I am Professor of Epidemiology at King’s 
College London

...might be enough if your podcast is directed at a fairly informed or academic audience, 
but for lay listeners, you might need something a bit more informative, such as...

 Guest: My name is Sarah Whoever, and I am a Professor of Epidemiology at King’s 
College London, where I study how groups of people behave…

You might not use this in the final edit, or may decide to re-record an introduction 
yourself, but if you don’t have it, then you don’t have the choice about whether to use it 
or not!

Asking questions
There are a few ways of asking questions, which will depend on the format you have 
chosen. Give your guest some guidance about how to answer questions as you go 
along, and how much of the question you want them to include in their response. 
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For example, if you wanted to know what your guest’s favourite colour is, and plan to 
include both the host and the guest audio tracks, it could sound like:

Host: What is your favourite colour?

Guest: Blue

Or if you didn’t want to include the host audio in the final edit, it might sound like:

Guest: My favourite colour is blue.

Or if you wanted the host to add some context or bridging later on it might sound like:

(Edited in) Host: I wanted to know a bit more about my guest and their favourite 
things.

Guest: My favourite colour is blue.

Some guests may default into technical descriptions or very long sentences. Others 
might say the same thing two or three times in slightly different ways, which is great if 
you are looking for soundbites, not so great if you are recording a roundtable. Don’t be 
afraid to ask people to say things again, or ask the question in a different way:

Host: What do you do for a living?

Guest: I am a Professor of Epidemiology, and specialise in strategies for statistical 
analyses of causal pathways, interactions, and trajectories of mental disorders.

Host: That’s sounds very complicated! How would you explain that to someone 
without expertise in this field?

A good host will acknowledge 
responses and offer a reflection or 
comment before probing further 
or moving on to the next question. 
Impersonal responses like “Great” 
or “That’s so interesting” can sound 
unprofessional to both the guest and 
the listener, and can also disrupt the 
flow between episode segments.
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Probing further
There are some questions or prompts you can use to probe further if you don’t get what 
you want from initial answers. If you have experience in qualitative research, you’ll 
already be familiar with some of these prompts:

• You mentioned X, can you say a bit more about that?

• How did that make you feel? 

• How would you explain that to (a specific group of people)?

• What would you say to people who have the opposite belief?

The last question allows you to indirectly challenge the guest without alienating them. 

As the guest is speaking, note down follow up questions. For example, if a guest is 
asked to describe depression, they might give a clinical description, whereas you 
wanted something that captures the lived experience. So you might follow-up and ask:

• What does depression feel like?

• What’s the difference between depression and feeling low?

Have some questions up your sleeve for putting people on the spot and making them 
defend their views, particularly in episodes where you’re debating a topic. For example:
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• What would you say to people who think that depression isn’t a real illness, and 
that people should just pull themselves together?

The key part here is not to challenge an idea directly! It’s a gentler way to keep your 
guest on side whilst engaging them with an argument.   

Keep the listener in mind
You should keep an ear out for technical descriptions or acronyms which listeners 
might not understand. Where possible, get your interviewee to explain these, 
otherwise you will need to add an explanation during the editing process, which could 
disrupt the flow of the conversation. For example, it could sound like:

Guest: I mostly use RCT in my research and...

Host: Sorry to interrupt, for listeners who don’t know what an RCT is, can you tell us? 

Guest: Yes of course, RCT stands for Randomised Control Trials, where participants 
are randomly assigned particular interventions, such as treatment methods, in order 
to evaluate its effectiveness. My most recent study used RCTs to explore...

Or if the host adds an explanation later it might sound like:

Guest: I mostly used RCT in my research...

(Edited in) Host: RCT is an acronym which stands for Randomised Control Trials. 
This is when participants are randomly assigned particular interventions, such as  
treatment methods, in order to evaluate effectiveness.

Guest: ...and recently explored the effects of 
a new treatment for this disorder.

If you get an answer which is confusing or not 
quite right, it’s fine to ask interviewees if you 
can ask the question again and record a new 
answer. For example:

Host: That was great, but I wonder if you 
could be more explicit about X… I’ll ask the 
question again, and we can record a new 
answer if that’s okay?
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Sometimes you’ll go backwards and forwards, and the interviewee might want more 
information about what you are looking for them to say. The trick is to find a middle 
ground so that they give you what they want, but it’s their view in their own words. 

You may want the guest to revisit something said in background conversations or while 
setting up the recording, or even in a separate interview or article. The host could say:

Host: Do you remember when we spoke / you talked about how…. Can you say 
something about that now we’re recording?

Managing interruptions
You are almost certainly going to have to deal with unexpected noises and 
interruptions which will interfere with the final episode. 

If a helicopter flies overhead, a police car drives by with siren blaring, or even if a 
remote connection has a bit of a wobble, you should pause the interview. Make it clear 
that it’s because of the external interruption, not because the interviewee has done 
something wrong. The host could say:

Host: Hang on a second, we won’t be able to use this bit because the helicopter is 
drowning you out, can we wait until it’s passed, then record this question again?

In the event that the interruption is more significant, for example they are needed 
for childcare or a builder starts work next door, you may need to change locations or 
postpone the interview.

Special considerations
There are also some things to consider for different formats.

Roundtable
It’s possible that one member of your panel dominates the conversation, and others 
are unable to make their points or contribute in the same way. Although you’re 
recording on separate tracks, this will still be difficult to edit. This is when the host 
must draw on their chairing skills, by explicitly bringing people into discussion, just as 
you would if you were chairing a panel discussion. The host must keep track of who 
speaks and for how long, and ensure there is balance in content and representation.

People may have similar voices and be hard to differentiate easily. The host can help 
the listener by using people’s names often, much more than you would in real life:
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Host: Thank you Charlotte, can I ask Gemma, what do you think?

You can also remind the listener about people’s roles

Host: Gemma, as a youth worker, what are your thoughts on this topic?

In-conversation with
The host should resist the temptation to say “yes” or ”really”. Although they can be 
edited out, they could be distracting or detract from your interviewee’s answers. 
But don’t fail to react at all! The host should give non-verbal encouragement for your 
interviewee to keep talking or elaborate – nodding, using facial expressions etc. 

It might be that an interaction between the host and the guest will add depth and 
interest, for example if they respond with a gasp to something shocking, or laugh at 
something delightful or funny. This can add warmth and relatability to the episode. 

What to do if an interview goes badly
If you have prepared properly, by researching your guest and outlining your questions 
in advance, it’s unlikely that an interview will go badly. However, it can happen for 
several reasons:  

Second thoughts
The guest may change their mind, not necessarily because of something the host has 
said. If they tell you they want to withdraw from the podcast - before, during or after 
the recording - you should respect their wishes. Tell them that you acknowledge and 
have no issue with their request, and that you will file their decision and destroy audio. 
Obviously, you should then delete the files and make a note on their consent form.

Emotional responses to questions
With some interviews, you may want to push 
guests a little, perhaps on issues where their 
views are controversial. However, you need 
to keep them onside so that they’ll continue 
to engage and not feel alienated. If you have 
potentially contentious questions, think about 
asking them towards the end of the interview 
rather than launching with them. If your guest 
becomes aggrieved by the line of questioning, 
apologise and ask if you can rephrase and try 
again, or if they would rather move on. 
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The person you’re interviewing may become upset, particularly if you are discussing a 
sensitive topic. An emotional contribution from an interviewee can be very powerful, 
but often comes at a cost. If someone becomes upset, you should always acknowledge 
their emotions, and ask if they want to take a break or stop the interview altogether. 
Let them know that they can ask for parts not to be included in the final edit. 

Depending on the topic (and your judgement) you could mention omitted questions or 
responses in the episode, but do keep guest consent and well-being in mind.

It just wasn’t right
Unfortunately, sometimes an interview may just not turn out how you expected. A 
guest may not given rich or long enough answers, or they aren’t particularly engaging 
to listen to. It may sound harsh, but you should always keep the listener in mind! 
However, even the worst interviews can produce at least one interesting soundbite. You 
may need to think about switching up your format or adding some interesting context 
or links to keep both the guest and the listener happy with the final episode.

Ending the interview 
Be mindful of the time – your guest may not have longer than the allocated slot! As the 
end of the interview draws near, the host can indicate how much time is left:

• I only have a couple more questions to go now.

• Sadly, this is my final question! 

It’s good practice at the end of an interview to ask whether there is anything the guest 
thinks you’ve missed, or anything they think it’s important to add. This is often where 
magic happens in the form of unexpected insights or experiences.   

When the interview is over, we recommend that you keep the recording going a while, 
during the debrief. There is often an audible sigh of relief when the host declares 
that they have reached the end! The guest relaxes, and a more casual conversation 
between them and the team may produce little gems for your episode. If this happens, 
do ask them if you can include this in the final episode.

When the REACH Project Young People’s Advisory Group 
took over Our Sick Society, we had lots of these little gems 
in between the formal interviews. See if you can hear any! 

https://soundcloud.com/oursicksociety/social-class-and-young-people
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Don’t forget to thank your guests, and let them know next steps and timeframes. 

Complete Task K on p46 for your end of recording checks.

Complete Task L on p47 for checks when secure your audio.

Securing your audio
Many podcasts have collapsed at the post-production stage because an essential 
interview can’t be found, or because a file has been corrupted. Whether remote or 
in-person, don’t forget to save, label and back-up your audio files immediately after 
recording has finished. 

Guest follow-up
Its good practice, and just good manners, to follow-up with your guest after the 
recording. Make sure you:

• Say thank you again!

• Give them a rough turnaround time for the episode

• Ask them for any external links or information they would like to be shared during 
promotion

• Point them to source of support if appropriate

It may be better to send this email to each guest individually, even if multiple guests 
were recorded together. While we don’t recommend explicitly asking the guest if there 
is anything they want cutting (this can affect your turnaround time if they ask for big 
changes or re-recording), by sending an individual email, you are giving them a private 
opportunity to flag anything they are uncomfortable with. 
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Section 5: Production
Tools and Resources

Ensure you tick off all of these key items during each recording
J: Before you hit record

(If using Zoom) Ensure there is enough space to save to computer

Consent reminder

Sound / Equipment check

“Noise maker” check - jewellery, papers etc.

(If using Zoom) Ask them not to mute microphone at any time

Host questions and notepad for prompts ready

(If using Zoom) Select “Record to Computer”

Record warning

K: Ending the interview and follow-up

Anything to add / re-record?

Thank guests

Indicate anticipated release

Request resources and/or promotion support (account handles/websites etc)

Confirm who they can contact with questions

Refer to support if required
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L: Secure audio

Export files to computer

Save in labelled folder

Name files (be consistent - Episode #, Recording #, Guest = E1AJane)

Save consent files using same naming convention (E1AJane_Consent)

Back-up files on SharePoint
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Section 6: Post-Production

After you have recorded all of your interviews, i.e. the raw material of your episode.  
What happens next depends to some extent on your chosen episode format. However, 
the first step is usually transcription of your audio.

Transcribing
Transcription is important for three reasons: 

• It helps you to review and find content

• It makes the editing process much easier 

• You can upload the transcription to your podcast website to improve accessibility 
and outreach of your episode.

There are lots of online solution for preparing these transcriptions, such as Otter or 
Trint. Both are incredibly accurate and can even detect different voices, making the 
transcriptions very close to those made by a human. Both also offer a free allowance 
per month before premium pricing kick in. Depending on how much you need 
transcribed, and how regularly you will require the service, you might fall under the 
payment threshold but if not, it’s most certainly a service worth paying for. 

Whether you transcribe manually or with an online 
solution, you should be consistent with your format. 
Use consistent labelling for voices, time codes, and 
highlighting. In other words, make it easy for the 
editor to find what needs keeping or cutting!

Here are two example transcriptions, which we’ll use 
throughout this section.

Note: example interview material is illustrative 
rather than real, but they have been informed 
by the BEAT charity website, a leading eating 
disorders charity.

https://otter.ai/
https://trint.com/p/landing/transcription-tool?utm_source=adwords&utm_medium=ppc&utm_campaign=GB|Brand&utm_content=1469689085|57271677256&utm_term=kwd-379687020127&hsa_acc=7521317472&hsa_cam=1469689085&hsa_grp=57271677256&hsa_ad=405521692529&hsa_src=g&hsa_tgt=kwd-379687020127&hsa_kw=trint&hsa_mt=e&hsa_net=adwords&hsa_ver=3&gclid=CjwKCAjwzaSLBhBJEiwAJSRoktpeCxhd_T-oP9Vkns30jvTZ5OmJMrRIvHb8pnnxM7T3Ir9u34zT1RoCt1QQAvD_BwE
https://www.beateatingdisorders.org.uk/
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File Name Interview A – Jane

Speaker Time Transcription

Interviewer 00.01 Can you tell me your name and title for the recording please

Jane 00.05 I’m Jane Smith, I’m a post-doc researcher at King’s College London where I 
work on a study called IMPRINT

Interviewer 00.15 That’s great, but can I ask you to do it again and this time tell me a bit 
about what IMPRINT is?

Jane 00.45 Oh gosh, I’m sorry, it’s more difficult that you think

Interviewer 00.50 I know, seriously, don’t worry, it happens to everyone, just give it another 
go, and it will get easier when we get into the actual interview

Jane 01.00 My name is Jane Smith, I’m a post doctoral researcher at King’s College 
London where I research anorexia nervosa on a study called IMPRINT

Interviewer 01.15 Thanks Jane, Tell me about IMPRINT – what are you trying to find out?

Jane 01.20
IMPRINT is a study led by Professor Marjorie Simpson where look at how 
people with anorexia nervosa think about choosing clothes to buy, and 
whether those choices are tied to their perceptions about their bodies.

Interviewer 01.40
Is anorexia nervosa the same as what most people usually call anorexia?  
And for listeners who might not know what anorexia nervosa is, can you 
explain a bit about it?

Jane 01.50

Yes, most people would call it anorexia, but its full name is anorexia 
nervosa. In fact it’s a serious mental illness where people maintain a low 
weight by limiting how much they eat and drink. They may develop “rules” 
around what they feel they can and cannot eat, as well as things like when 
and where they’ll eat.

Interviewer 02.10 I think most people when associate anorexia with teenage girls?

Example A: Interviewing an academic colleague
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Jane 02.15

Yes, but in fact anorexia can affect anyone of any age, gender, ethnicity 
or background. We are increasingly seeing more young men developing 
anorexia for example. And there are also many people for whom anorexia 
persists into middle age, even older age groups have anorexia. The longer 
anorexia goes on, the more difficult it is to treat.

Interviewer 02.35 So why is IMPRINT so important?

Jane 02.45 Anorexia nervosa often goes alongside body dysmorphia and

Interviewer 02.50 Sorry to interrupt, body dysmorphia, what is that exactly?

Jane 02.55

Body dysmorphia is when...the way someone sees themselves and their 
body is at odds with how others see them. In other words they have a 
distorted image of themselves, in this case, they think they are larger 
than they really are. We know this can lead to them checking their body 
regularly, or trying to avoid scales and mirrors. What we don’t know is 
whether their body dysmorphia affects their choices when buying clothes. 
It may be that they buy baggy clothes to cover up their body, or it may be 
that they buy dark colours so as not to draw attention to themselves. And 
we think this might be important because it could be that getting people to 
think differently about which clothes they buy might be a helpful way to get 
them to think differently about their bodies, and help with their treatment.

Interviewer 03.30 A kind of fake it to make it approach?

Jane 03.35
Well, recovery from anorexia nervosa is going to take more than just 
changing a person’s wardrobe, but this might be one thing that can work 
alongside other ways to help people’s recovery. But we don’t know at the 
moment, so that’s what IMPRINT will be looking at.

File Name Interview B: Katie

Speaker Time Transcription

Interviewer 00.01 Can you tell me your name please 

Katie 00.03 My name is Katie

Example B:  Interviewing someone with lived experience of a mental health condition  
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Interviewer 00.07 Thanks Katie, and as I explained, we are making a documentary about 
anorexia, can I ask you to tell me a little about your experiences?  

Katie 00.13

Yeah, well, I’ve, erm, I mean, I well, I suffered from the age of 12 until I 
finally sought help at the age of 24. At that point, I was pretty desperate 
and hopeless. I thought that change would never ever be possible and 
therapy was such hard work. It took a long time but I eventually entered 
recovery and have never looked back. My life now is wonderful - and I never 
thought that possible.

Interviewer 00.30 And when you were in the depths of your anorexia, what was that like? 

Katie 00.35
I thought about food and calories all the time. I tried to avoid foods 
containing lots of fat or carbohydrates and only had ‘safe’ foods which I felt 
were okay to eat.

Interviewer 00.45 That sounds like a nightmare 

Katie 00.50
It was, I had a 'voice' in my head that shouted at me. It told me I was fat 
and worthless and that I was not allowed to eat because I did not deserve 
food. I thought I was in control of my eating but it got harder and harder to 
ignore the voice.

Interviewer 01.10 What effect did all of this have on you? 

Katie 01.15
As I lost weight I began to feel tired and this made me more depressed. 
I couldn’t think straight or concentrate at school. All I could think about 
was food because my brain and body was craving for it. I realise now I was 
suffering from the effects of starvation.

Using links
Now we have our content laid out, we can start to make sense of what the episode 
might look like. Even the most simple set of recordings need to be reviewed carefully 
-  if you simply chopped audio from your contributors, or edited down one long “in 
conversation with” interview, there is unlikely to be a consistent narrative, and this 
makes it difficult for the audience to understand the story you are presenting. 

Instead, your host should record context in between clips, also known as “bridges” or 
“links”. These help to bring a coherence to the narrative, making everything flow better.   
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You could use links to signpost the listener to something what they are about to hear :

Host: I spoke to Doctor Medicine at the World Health Organisation and asked them 
about rates of mental illness in low and middle income countries… 

Or who they are about to hear from: 

Host: We’ve heard a lot from the clinicians and research scientists about the impact 
of Covid-19 on mental health, but now let’s hear from Amanda, who has lived with 
a diagnosis of bipolar disorder for many years now, and whose experience of the 
pandemic has been far from easy…

 You can use links to signal a change in direction. 

Host: But what about our politicians?  Why are they so silent on this subject? 
Matthew has a view on that…

Links also allow the presenter to insert information for context which maybe didn’t 
come out well in the interviews:

Host: We know that anorexia nervosa is one of the most costly of all mental illnesses, 
with one of the highest mortality rates. But what work is being done to support those 
living with anorexia? Let’s hear from a researcher with an interesting approach...

You can use links in lots of interesting and useful ways - to sum up content, ask 
questions to the audience, to inject a note of the personal, the list goes on. Links are a 
way of bringing colour and life to your story.  

If you have favourite podcasts, particularly those using a documentary format, try 
listening to them while paying particular attention to the links. As with all aspects of 
podcasting, if you hear something that works well, adapt it for your own podcast.  

Paper editing
After transcription, you need to carry out some sort of “paper edit”. This is when the 
structure and content to be included in the final episode is outlined. 

Sketch out the episode 
Before you start, outline the rough structure of your episode. Let’s say you want to have 
a 45 minute episode, split into three sections, including a standardised intro and outro 
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(we’ll look at this later in the section). This gives you roughly 40 minutes to play with, 
which is good to keep in mind.

Identify your content
First, gather each of your recordings, transcripts and timings. Your team, and most 
importantly the person editing the episode together, should agree on an editing 
system. You might take each transcript and cross out words or sections, or just 
highlight parts to keep. You could also use notations or instructions to the editor. This 
is why transcripts are so helpful - you can review them, read them and mark up what 
feels important to include. 

The format of your episode will affect how complicated this process will be. If you 
have recorded a panel discussion, you might simply need to highlight hesitations or 
repetitions to be taken out, or parts where links are needed to add context. If however 
you are using a documentary style format, your paper edit will be more complicated. 
You will need to go through each transcript and:

• Find soundbites which work on their own

• Find connections between sections and quotes

• Highlight bits to be removed or enhanced (e.g. increase volume)

• Identify links needed to join up sections

With this format, you will only be able to use a small amount of each interview, and 
they could end up in a different order to how it was recorded, or indeed mixed with 
parts of other interviews. 
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Example C: Worked example of a paper edit

File Name Episode 1 paper edit

Episode timing Source Start time End time Notes

00:00 - 00:30 Theme & Intro 00:00 00:30 Full intro - no need to re-record

00:30 - 02:00 Episode 1 - Host 
links

00:00 01:30

Yet to be recorded.  
My name is Amanda, and welcome 
to this episode of our podcast series 
Innovation in Research. This week 
we will be exploring hidden aspects 
of anorexia nervosa...

02:00 - 03:14
Interview A: 
Jane 01:00 01:14

Start: My name is Jane....

End: ...on a study called IMPRINT

03:14 - 03:19 Episode 1 - Host 
links

01:45 01:50 Yet to be recorded. 
I asked Jane to explain...

 03:19 - 03:37
Interview A: 
Jane 01:51 02:09

Start: Most people would call it 
anorexia, but its full name is...

End: ...They may develop “rules” 
around what they feel they can and 
cannot eat, as well as things like 
when and where they’ll eat.

03:37 - 04:07
Episode 1 - Host 
links 01:55 02:25

Yet to be recorded.  
Katie had anorexia for 12 years. She 
explains what this felt like...

Let’s say we recorded the above example interviews because we are making a 
documentary about hidden aspects of anorexia nervosa. We now need to take all those 
clips and spaces for links to create something which is close to a script. In the worked 
example below, we are working with the two example interviews, plus an already 
recorded Theme and Intro; and a file with section links recorded by the host.
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04:07 - 04:16
Interview B: 
Katie 00:35 00:44

Start: I thought about food and 
calories all the time. I tried to 
avoid foods containing lots of fat or 
carbohydrates...

End: ...and only had ‘safe’ foods 
which I felt were okay to eat.  

04:16 - 04:38
Interview B: 
Katie 00:51 01:13

Start: ...I had a ‘voice’ in my head 
that shouted at me. It told me I was 
fat and worthless and that I was 
not allowed to eat because I did not 
deserve food. 

End:...I thought I was in control of my 
eating but it got harder and harder to 
ignore the voice.

04:38 - 05:08 Episode 1 - Host 
links

02:30 03:00
Yet to be recorded.  
Dealing with those negative opinions 
about the body is a key part of the 
illness. Here’s Jane again

05:08 - 06: 12 Interview A: 
Jane

02:55 03:10
Start: Body dysmorphia is when...

End: ...they think they are larger than 
they really are.

As you piece the episode together, your material may take you in a different direction 
than originally planned - and that’s okay! Refer back to the episode plan and your 
overarching objectives. What story did you want to tell? What were the key messages? 
If you can’t fulfil those objectives you may need to re-edit or re-record content.

Review paper edit against your audio
Take time to listen back to selected audio. Sometimes there are words and sentences 
which look perfect on paper but in audio form are very difficult to edit. Cadence and 
intonation need to be considered - the person might be speaking quickly with run-on 
sentences, which is very hard to edit! You could end up with a nice, isolated clip or a 
jarring heavy-handed cut, which makes a difference between a great sounding podcast 
and one which takes you out of the flow as a listener.
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Audio editing

Later in this section, we will provide basic instructions on how to edit your 
episodes using Audacity - free podcast editing platform available online.

Once the paper edit has been completed, and any additional presenter links have been 
recorded, you are ready to start audio editing. With any luck, the edits can be made 
without any sudden cut-offs and chops, allowing the audio to flow nicely. 

This might mean a simple job of deleting unwanted audio from one long recording, 
but sometimes it might mean taking separate chunks of audio from various sources to 
build the episode outlined in your paper edit.

This is a good time to take care of any extraneous sounds, the “umms” and “ahhs” and 
so on, which might occur on the audio. Do this when you are breaking audio down into 
chunks, as that can make the task a little easier, as you’re focusing on individual pieces 
rather than a whole long file . It’s good to have clean audio for final assembly.

As you work through the episode, keep track of edits made, adjustments to edits, and 
any issues on the paper edit.

Including music 
Music can be a subtle force, providing mood and emotion to your episode. Badly used 
though, it can feel overbearing or inappropriate. You can include music as:

• A repeated theme tune

• Background sounds

• Interludes between sections

• A standalone feature 

Beware of falling into clichés! Many 
mental health podcasts feature a 
mournful piano, but if you are trying to 
demonstrate hope or show that people 
with mental ill health can lead productive 
lives, a sad piano doesn’t reflect that!

https://www.audacityteam.org/
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While you may have a favourite track in mind, chances are that you can’t legally use it! 
Websites like Pixa Bay and Canva have royalty free music options.

Use of sound effects
Sound effects can be used as elements of ‘theatre of the mind’ - by which sound is 
used to conjure vivid imagery in the audiences’ minds. It’s never necessary to ‘Micky 
Mouse’ everything - the sound effect-ing of every action - but when used sparingly and 
at opportune moments, they can add a nice flourish, or awaken the senses a little.

Open new segments
You might hear a scrape of a chair or equipment noise, which can add to the feeling of 
being in someone’s company, rather than sitting with a disembodied radio voice.

Separate content
If the episode jumps between segments, you could add effects to help the listener 
distinguish them from one another. For example, if the host includes a quote from a 
book, you could include the sound of a page turning or add an effect to the voice to 
make it sound like it’s an old cassette tape. 

Illustrate the topic
Sound effects can be used to illustrate a point being made in your podcast. For 
example, if you are talking about darts, you could use the thwack of darts into a board 
as punctuation. 

Provide a sense of place
This works particularly well if you are filming 
on location, or if you want to emphasise the 
importance of place. For example, if you are 
interviewing a guest in a seaside café, you might 
include seagulls in the background or perhaps a 
hiss of a coffee machine. This works particularly 
well if the location is explicitly referred to in host 
introductions or links.

For Episode 5: Music for the Mind, we explored music, 
mental health and wellbeing. We therefore used music in 
different ways. Listen to how music was used throughout.

https://pixabay.com/music/
https://www.canva.com/help/article/stock-music
https://soundcloud.com/oursicksociety/music-for-the-mind
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Editing your podcast using Audacity

This part of the toolkit provides an overview of basic editing 
in Audacity. Click here to download Audacity. For detailed 
instructions, refer to the official Audacity manual.

Before you start 
Make sure you have back-ups files of all your original recordings! Open Audacity to 
begin editing.

Functions
Here are some useful buttons on the toolbar:

Create your episode file
From the File Menu, tap New to create an empty project window. This will be the 
working environment, into which you will import your audio files.

Tap File Menu > Save Project to save the file as an Audacity Project File.

https://www.audacityteam.org/download/
https://manual.audacityteam.org/index.html


Creating a social sciences podcast: A toolkit for researchers 59    

Load your audio

• Click on File > Import > Audio

Note: You can also use Open but this will open each audio file in a new tab

 This is what you’ll get:

Note: This audio is recorded in stereo. If you have a mono recording, you will only see 
one track.

Noise reduction
This is used when you have instances of hiss, background noise, hums, fuzz or 
otherwise continuous unwanted sound on the recording. It’s not always entirely 
removable, but modern software certainly gives it a good try and can often save a 
recording! Planes and cars can be difficult as they will have a fluctuating pitch, but 
when you have a consistent noise (like a laptop fan), it will be easier to remove.

You should have a few seconds of just ‘silence’ at the start of your recording. 

• Tap the Selection Tool (or press F1) and highlight that part of the track
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• Click Effect > Noise Reduction

• Select Get Noise Profile - this will take 
the selected ‘silence’ and mark it as 
background noise
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• Highlight the whole recording (click on the info box to the left of the track)

• Click Effect > Noise Reduction > OK

This will remove all the background noise 
in your recording.

Deleting audio
For any audio that needs cutting or 
removing entirely, you can use the Delete 
function.

• Tap the Selection Tool and then click and drag your cursor to highlight the part of 
audio you want to remove

• Press Delete on your keyboard (or BACKSPACE / COMMAND + BACKSPACE)

Splitting audio
A ‘non destructive’ edit – this basically means the file itself will not be permanently 
affected, it’s only telling the software to see a break in the file. It’s almost like cutting 
the file with some scissors – you can then move the cut part to another place in the file. 
This will be particularly useful if you used a format with multiple guests, for example a 
documentary style or roundtable discussion.
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• Tap the Selection Tool and then click and drag your cursor to highlight the part of 
audio you want to split and move

• Click Edit > Clip Boundaries > Split

Moving audio
This function is most useful when adding music / joining different recordings, for 

example if you have included multiple guests, or where you are moving content around 
to suit your story.

• Tap the Time Shift Tool > Click on the audio and drag left or right to move

Adjusting volume
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This is a really helpful function which you can use, for example, if someone sits too far 
from the microphone, or if there are there are background noises such as breathing. 
You may want to keep the main audio in but make them quieter!

• Highlight the selection > Click Effect > Amplify

• Move the ‘needle’ left 
or right (minus number 
= lower; plus number = 
higher)

• Click OK
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Adding multiple audio tracks and music
You can add more than one audio file, for example if you are adding recordings of 
multiple guests, or when you need to add the intro and outro for your episode. The 
process is the same as opening the first audio file.

• Click on File > Import > Audio

• Each new file will open directly underneath the first one

• Use the Time Shift Tool to move them around (see Moving Audio)

Fade in and out
You might want to have your music (e.g. 
intro soundtrack) slowly fade in or out

• Highlight the part of audio that you 
would like to fade.

• Click Effect > Fade In/Out



Creating a social sciences podcast: A toolkit for researchers 65    

Save and export your project
When you save an Audacity project you are doing just that - saving an Audacity project 
file, which can only be opened by Audacity. To save the project file:

• Click File > Save Project > Save Project

To end up with a file to upload onto your podcasting platform, we need to export it.

• Click File > Export > Export Audio... - the standard Save dialog for your operating 
system appears.

• Give the file a different name. 

• Choose a location to save the file.

At the bottom of the Save dialog is a dropdown menu labeled Format. 

• If you have used high-quality audio files (i.e. higher than .mp3), you can save as a 
.WAV file. You do not have to change these settings. Tap Save.
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• If you only have .mp3 files (usually via Zoom (S), you will need to save as an .mp3. 
You will need to adjust the quality settings by tapping Options. Pick the best option 
available! Tap Save.

Complete Task M on p67 to run through your editing checklists.

For more detailed instructions, see the official Audacity Manual

https://manual.audacityteam.org/index.html
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Section 6: Post-Production
Tools and Resources

M: Episode editing checklist:

Trailer recorded and edited

Intro recorded and edited

Outro recorded and edited

Music files created / downloaded and stored

Episode audio files saved and collated

Assets

Transcriptions completed

Paper edit prepared

Paper edit reviewed and confirmed

Host links recorded

First audio edit prepared

First audio edit reviewed

Host links re-recorded (if needed)

Final changes made

Final edit signed off

Process
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Once you have completed 
episodes lined up, and of 
course any consent forms 
signed and filed, we are 
now ready to go live!

Select a hosting platform
Our first step is to select 
a platform to host your 
podcast. Podcasts can be 
uploaded and distributed 
via a wide range of 
platforms, and the choice 
can be intimidating! 

A popular choice for 
King’s podcasts is 
Soundcloud. This is a site 
which originated in music sharing, but has since gained many users after introducing 
podcast distribution. A Soundcloud player for full series or individual episodes can be 
embedded onto King’s web pages, which is very handy.

While a basic Soundcloud account is free, you may need to pay for a Pro account if you 
have over 3 hours of audio, or if you want to know a bit more about your audience.

Another popular platform for King’s podcasts is Acast, which also offers various 
account options, but which cannot currently be embedded on the King’s website.

Upload your trailer
This may feel like a strange step in the middle of setting up your podcast! 

It is very important to have one ‘episode’ uploaded and live when setting up the 
podcast. This makes it easier to set up and validate the aggregator accounts (see 
below) to disseminate your episodes. Rather than launching the first episode, we 
recommend starting with your trailer which gives a chance to both build momentum, 
and iron out any issues with the platform!

Section 7: Going live

https://soundcloud.com/
https://internal.kcl.ac.uk/content-editors-hub/webpages-cms/widget?id=137badd1-bb22-4af1-92a5-f6e3bdecc89a
https://checkout.soundcloud.com/pro
https://www.acast.com/
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RSS Feeds
When you set up your podcast hosting platform , you will also end up with an RSS 
feed. RSS can stand for, among other things, ‘Really Simple Syndication’ (the most 
easily understandable of the possible meanings!). Basically, an RSS feed allows users 
to subscribe and listen to your podcast on other platforms, known as aggregators or 
directories, such as Spotify, Apple Podcasts and Stitcher.

You will need to find the RSS Feed URL in your podcast hosting platform settings:

• Soundcloud - Settings > Content > RSS Feed

• Acast - Distribution > RSS Feed (bottom of page)

Then you will need to link and verify your podcast on the aggregator platform. This is 
why uploading the trailer is important, as it confirms that you have content ready!

• Apple - https://podcastsconnect.apple.com/ 

• Spotify - https://podcasters.spotify.com/

• Stitcher - https://partners.stitcher.com/join

Complementary content
There are several types of content that listeners may want to look at after listening to 
an episode. Such as:

• Resources mentioned in the episode: 
Books, papers, reports, or projects 
referred to by guests.

• Complementary resources: Videos, 
other podcast episodes or news articles 
which are related to content.

• Sources of support: If you are covering 
a topic which is sensitive or potentially 
upsetting.

• Transcripts: For accessibility purposes.

https://podcastsconnect.apple.com/ 
https://podcasters.spotify.com/
https://partners.stitcher.com/join
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Listeners sometimes need to do a bit of digging to find links to external content, and 
some platform sites, as well as social media profiles only give space for one external 
link. One of the easiest and most popular ways of compiling and sharing multiple links 
is via a list app, which provides a single link to a page with a branded list of external 
links for your visitors to access. Our Sick Society uses linktr.ee but other popular 
alternatives include Campsite and Contact In Bio. 

Additional content, as well as the podcast itself, can be shared on the King’s website, 
either via a flat page on your departmental website (like Our Sick Society), or as a 
project page. Get in touch with your departmental communication team for more 
information.

Some podcasts also upload video of the podcast recordings to YouTube, which is also 
worth considering if the recordings can be made at a decent quality, though editing 
these can be a little trickier than audio. You will also need to obtain explicit content to 
distribute video of your guests. Click here for King’s guidance on editing video.

If you plan to market your podcast as a King’s product, you are 
bound to adhere to branding guidelines when designing your 
visual identity. You can find more information about King’s 
Branding here.

Visual Identity
The creation of a standardised visual identity for your podcast will strengthen your 
brand and influence audience perceptions, which will boost visibility and appeal. You 
will need a selection of artwork to promote your podcast:

Logo and Cover art
Many podcasts use the same image for both their 
logo and their cover art (i.e. the image you see on 
the platform); but you may wish to develop these 
separately. 

Your logo should be simple and easy to identify 
on a smart phone as well as larger device. Think 
about how the logo will be used in promotional 
materials and review versatility by overlaying it on 
a range of colours, patterns and images. 

https://linktr.ee/
https://campsite.bio/
https://www.contactinbio.com/
https://www.kcl.ac.uk/csmh/news-and-media/podcasts
https://internal.kcl.ac.uk/cphub/create/video
https://internal.kcl.ac.uk/erd/depts/brand-and-marketing-portal
https://internal.kcl.ac.uk/erd/depts/brand-and-marketing-portal
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Where possible, use colours from the official King’s colour palette, or those used in 
your Departmental branding. If you want to use more than one colour, you can use the 
free Canva Colour Wheel to find complimentary colour combinations. 

Make sure your logo is designed as a vector file - this will allow you to scale it up and 
down without losing quality. 

Our logo uses colours from the Centre palette, and includes 
our name and a bird’s eye view of a city. This image acts 
as both an abstract representation of the brain and as a 
picture of society itself! Unfortunately this is a tricky image 
to overlay due to all the colours, hence our emphasis on 
testing functionality first!

When it comes to designing your cover art - simplicity is key. The listener must be able 
to easily identify what your podcast is about, and ideally the overall style and tone. 

If you are developing a podcast on a specialist academic subject, you may want to 
think about how that topics translates into art. Take a look at the artwork used in these 
psychology podcasts on Soundcloud. Lots of the images use heads and brains in their 
visual identity – while this helps the listener to see what the podcast is about, using 
popular imagery can prevent your podcast from standing out. Canva has some handy 
templates for podcast covers to help you get started.

Look at this list of podcasts for curious minds put together by The Wired. 
Many covers are simple and striking - but what can you determine about 
the show just from colour palettes, fonts and imagery used? 

Platform Artwork
You will also need to develop artwork for your chosen streaming platform(s). These will 
usually consist of a profile picture, episode covers, and possibly a header image.

For those under the King’s brand, your cover art should have the King’s logo overlaid. 
This will maintain consistency with other podcasts, as well as content across your 
platforms and social media account. This will also help people easily spot you! 

https://internal.kcl.ac.uk/erd/depts/brand-and-marketing-portal/design-and-vi/design-at-kings
https://www.canva.com/colors/color-wheel/
https://www.adobe.com/uk/creativecloud/design/discover/vector-file.html
https://soundcloud.com/search/people?q=psychology%20podcast
https://soundcloud.com/search/people?q=psychology%20podcast
https://www.canva.com/podcast-covers/templates/
https://www.canva.com/podcast-covers/templates/
https://www.wired.co.uk/article/best-podcasts
https://soundcloud.com/kings-college-london
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For episode covers, you could re-use your podcast cover, which is what we do for Our 
Sick Society. Other podcasts - such as Criminal - like to use different themed images 
for each episode. You should think about the capacity of the team to source or design 
different images for each episode – it is a nice idea, but easier and cheaper to use the 
same image each time! 

Header images are required for Soundcloud, and you should be consistent in your use 
of imagery and branding. Our Sick Society uses the same image in our header that is 
used in our cover art, but with a wider crop. Each platform will have its own size and 
resolution requirements. You may also want to create a Hero banner image for King’s 
web pages. Here are the requirements:

• Soundcloud banner  image – 2480 x 520 pixels – Canva template

• King’s Hero banner image – 1903 x 558 pixels – King’s image sizes

Marketing the podcast
It is important to think about how people will find your podcast - this is where your 
marketing and communication (MarComms) strategy comes in:

• Marketing: the action of selling products or services, including research or, in this 
case, the podcast!

• Communication: the process of exchanging information and influencing 
perceptions, or what we want to say to people so they listen to episodes!

The good news is that you started developing your strategy in Section 1! A strategy 
should include:

• Purpose - what are we communicating and why?

• Audience - who are you targeting?

• Key messages - breaking down your objectives into messages for the audience

• Methods - how will messages be communicated?

• Schedule - when should messages be communicated?

• Support - who can help you share these messages?

https://soundcloud.com/oursicksociety
https://soundcloud.com/oursicksociety
https://soundcloud.com/criminalshow
https://www.canva.com/web-banners/templates/soundcloud-banners/
https://internal.kcl.ac.uk/content-editors-hub/webpages-cms/image-sizes
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Now we will work through a series of questions to prepare a formal strategy.

Purpose
Think creatively about how MarComms activities can help you achieve your wider 
objectives. Let’s use an example objective from Our Sick Society:

• To achieve 1000 listens by the end of August 2021 

One obvious purpose of our strategy is to get our target audience to listen to episodes, 
but we also want them to share, subscribe and review to increase our reach and meet 
the objective. To make this easy for our audience, we can design content such as:

•   Episode trailers

•   Links to aggregator platforms 

•   Requests to review the podcast

•  Campaigns to “round up” listen numbers

Some objectives may be a bit harder, though not impossible, to tackle, particularly 
those based on audience behaviours. Remember, qualitative data is just as (if not 
more) valuable as quantitative data when measuring impact. For example, if you want 
to find out if your listeners are more aware of mental health support you can create 
content such as:

• Polls and surveys

• Requests to share content / 
make recommendations

• Information sharing threads or 
blogs 

You can then use both responses 
and engagement data to monitor 
and evaluate progress made in 
reaching this objective. 
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Audience
We have already looked at types of audience Section 1 . While broad categorisations 
are helpful when we plan episode content, we now need to look at our target audience 
in more detail. This is because different audiences will find and engage with podcasts 
in different ways. Consider how your podcast, as well as individual episodes, will 
appeal to audiences based on the following criteria:

• Age: Either by age-group (e.g. 30 - 35) or by generation (e.g. millennials, Generation 
Z). Example: But Why is targeted at under 18s.

• Gender: Some podcasts are targeted towards specific genders, usually because the 
theme is gender related. Example: hey girl shares stories by women for women. 

• Location: Could be a city, country or region. If your podcast is focused on say, 
London or England, then global appeal may be limited. Example: Bowery Boys 
explores the history of New York City.

• Profession: These could relate to broad categories such as academics or students, 
or could be more specific such as “senior school teachers”, “mental health nurses” 
or “policy researchers”. Example: Fast Track Impact was a podcast for researchers.

• Specific interest: All content relates to a particular topic or theme. Example: Making 
Gay History explores historical portraits of LGBTQ+ figures.

Key messages
Now we have an idea about our target audiences and their ideal responses, we need 
to identify key messages to communicate to them. These should be closely aligned 
to your podcast objectives, but be more centred on talking to the audience directly. 
Identifying key messages for each of our target audiences can help us to avoid 
miscommunication. 

Watch this short video to better understand what we mean by 
miscommunication: TED | How miscommunication happens (and how 
to avoid it)

Avoiding miscommunication will be particularly important if you are addressing 
sensitive or complicated topics and themes in your podcast. 

https://www.npr.org/podcasts/474377890/but-why-a-podcast-for-curious-kids?t=1624895542720&t=1636648244082
https://cms.megaphone.fm/channel/heygirl?selected=ADL3767901460
https://www.boweryboyshistory.com/
https://www.fasttrackimpact.com/podcast#:~:text=The%20Fast%20Track%20Impact%20Podcast,based%20on%20the%20latest%20research.
https://makinggayhistory.com/
https://makinggayhistory.com/
https://ed.ted.com/lessons/how-to-avoid-miscommunication-katherine-hampsten
https://ed.ted.com/lessons/how-to-avoid-miscommunication-katherine-hampsten
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Methods
You should plan to develop three broad types of marketing content about your podcast:

• Podcast content: focused on the podcast and your themes

• Episode content: specific content for each episode

• Special content: targeted one-off content, for example, for national holidays 

When developing content, remember to 
consider your overall brand. What is your 
tone? What are your key messages? How 
do you want the audience to engage with 
the episode content? You may need to pull 
out quotes or key commentary for your 
promotional materials. 

According to Sprout Social, 68% of content 
consumers want to engage with images, and 
50% with video. We recommend preparing 
the following types of content:

The overarching objective of the Our Sick Society podcast is 

for listeners to better understand the relationship between 

social changes and mental health, and to shift emphasis 

away from individual causes. However, key messages vary 

for our different target audiences – we want policy makers 

to respond to our episodes in a different way than young people for example. A key 

message for our policy maker might be that “Policy makers and researchers at the 

Centre for Society and Mental Health can and should collaborate on mental health 

strategies”, which may encourage a policy maker to reach out to one of our guests 

to hear more about their work.  A key message for a young person might be “The 

Covid-19 lockdown has had a negative impact on the mental health of many young 

people, but support is available”, which may encourage them to seek support. 

https://sproutsocial.com/insights/social-media-statistics/
https://sproutsocial.com/insights/social-media-statistics/
https://sproutsocial.com/insights/social-media-statistics/
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• Trailers: Use small snippets of your episode to create trailers. Our Sick Society uses 
the free limited package from Headliner – here is an example.

• Quotes: Pull out very short quotes from the podcast and create visual “quote cards” 
for your platforms. Canva have lots of templates for different platforms.

• Infographics: These can cover what was discussed in each topic or can highlight 
data related to your episode. Canva have templates you can use.

The channels you pick to promote your podcast will largely depend on your target 
audiences. Here are some popular options and helpful tips:

Twitter
Twitter averages 396 million monthly active users. As of January 2021, most of its users 
are aged between 18 and 49 years, with 62% being men and 38% women. The platform 
is vastly popular for live commentary of events and or entertainment shows.

Twitter is widely used by academic researchers across the world and can be a very 
effective way to establish networks, participate in debate and discussion related 
to your research, and share information with colleagues. The platform can also be 
a powerful mobilization and campaign tool, as we have seen with the momentum 
behind the 2019 climate strike. 

Here are some tips for posting on Twitter:

• Word limit: try not to cram everything into the 280-character limit. The shorter the 
tweet, the higher the engagement. Emoji’s, in moderation, can boost clicks.

• Hashtags: include relevant hashtags for your chosen topic. Don’t use too many and 
do your research to find trending or popular hashtags.

• Media: Tweets with photos, infographics and video (i.e. trailers or clips) have higher 
engagement. Ensure links have an image preview or replace with a relevant image.

• Follow target audiences: research and follow groups, organisations or individuals 
who specialise in your theme or specific topics covered by your episodes. Look at 
Lists and hashtags for inspiration. Ask guests for tips on who to follow.

Have a go at making some content using Twitter templates from Canva

https://www.headliner.app/
https://twitter.com/SickSocietyPod/status/1390254320378068993?s=20
https://www.canva.com/create/quote-graphics/
https://www.canva.com/create/infographics/
https://www.statista.com/topics/737/twitter/#dossierKeyfigures
https://www.canva.com/twitter/templates/posts/
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Facebook
As of July 2021, almost 2.89 billion people use Facebook every month, although an 
estimated 5% of accounts are thought to be fake. In terms of binary gender, 56% of 
global users are male, with the biggest represented group being males aged 25 – 34 
(almost 20%). Most adults check their account at least once a day, usually via phone. 

Facebook is a tricky platform for academics, as there is personal information on 
individual profiles which you may want to hide from the general public. However, you 
could use a Group page as a “faceless” platform for your audience to come together 
and discuss themes from your podcast. Facebook is an appropriate platform if you are 
targeting non-professional or academic audiences. Here are some tips for posting on 
Facebook: 

• Research group pages: see what other podcasts are sharing on their Group pages, 
and the level of engagement with different types of posts. Also review how much 
moderation may be needed to make the Group safe for all your users.

• Visual content is key: videos and images see more engagement on this platform, 
so you’ll need to develop this type of content for your audience.

• Utilise Facebook Ads: Facebook Ads are a really effective, albeit sometimes costly, 
way of promoting your podcast . Review your budget to see if you can afford it.

Have a go at making some content using Facebook templates from Canva

Instagram
As of July 2021, there are currently 1 billion active users on Instagram. Over two thirds 
of users are under the age of 34. Audiences are fairly even by binary gender: 51.4% 
female and 48.6% female. Here are some tips for using Instagram:

• Visual content: all content should be visual, so you’ll need a plan specific content, 
using the correct dimensions for this platform.

• Hashtags: as with Twitter, make sure you research and include relevant and popular 
hashtags to expand your reach.

Have a go at making content using Instagram templates from Canva

https://www.statista.com/topics/751/facebook/#dossierKeyfigures
https://www.canva.com/facebook-posts/templates/
http://statista.com/topics/1882/instagram/#dossierKeyfigures
https://www.canva.com/instagram-posts/templates/
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LinkedIn
LinkedIn is a business and employment focused social networking site used by 
recruiters or professionals for collaboration and professional networking. It has around 
610 million users, 57% of which are male and 43% female. 60% of users are between 
25- 34. You can predominantly use LinkedIn to share posts about your podcast and 
related news of interest to your network. Here are some tips for using LinkedIn:

• Written content and links: Unlike other platforms, most content consists of a 
written post with links to external articles and resources. The ideal length of a post 
is around 100 characters, so keep it brief and direct the reader to action.

• Utilise pages: You can create a Page for your podcast, and link to relevant King’s 
Departments where appropriate.

• Be professional: As you will need to link to your own profile to a Page or indeed add 
the podcast to your experience, ensure that content shared is professional and more 
formal than content for other platforms.

Have a go at making content using LinkedIn templates from Canva

YouTube
Almost 5 billion videos are watched on YouTube every single day! According to 
Hubspot, YouTube is available in over 90 countries in over 80 languages. There are 2 
billion users, 45% of which are female. 21.2% of YouTube’s global audience is between 
25 and 34, and 17% between 35 and 44. YouTube is not only used by individuals, but 
also by businesses and academics to increase their reach. Here are some tips:

• Complement don’t replicate: Instead of uploading your podcast as a video, create 
additional content which complements each episode. By posting the same content 
in two places, you will reduce the number of listens and lower your visibility.

• Keep it short: Videos created to support a podcast episode should be short – ideally 
no longer than 15 minutes.

• Speak to King’s Branding: All videos need to follow the King’s branding guidelines.

Have a go at making content using YouTube templates from Canva

https://www.statista.com/topics/951/linkedin/#dossierKeyfigures
https://www.statista.com/topics/951/linkedin/#dossierKeyfigures
https://www.canva.com/templates/?query=linkedin
https://blog.hubspot.com/marketing/youtube-demographics
https://blog.hubspot.com/marketing/youtube-demographics
https://www.canva.com/templates/?query=linkedin
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Other platforms
For younger or specialist audiences, you may also want to explore platforms such as 
Snapchat, TikTok and Reddit. However, make sure you review privacy and account 
requirements before opening any new accounts.

Schedule
You want to maintain a good momentum of interest in the podcast in between 
release of episodes. This can be tricky if you have limited capacity! You can use an 
external scheduling app such as Hootsuite (you will need some budget), or basic free 
scheduling in selected apps. Tweetdeck is a good option for Twitter, and if you have 
over 1000 followers, you can also use Studio to identify times based on traffic.

Sharing external content
As well as creating your own content, many communication specialists recommend 
utilising the Rule of Thirds to generate interest and followers: 

• 1/3 = promoting the podcast (i.e. links to episodes or posting trailers)

• 1/3 = engagement with users (i.e. liking, sharing or commenting on content) 

• 1/3 = sharing relevant content (i.e. news stories or papers on your podcast theme)

This is basically the comms version of not being the person who only wants to talk 
about themselves! It’s really helpful to follow lots of accounts on your channels, or 
create a Google Alert using key words from your podcast plan. This will provide a 
regular flow of external content you can use to draw audiences to episodes.

http://hootsuite.com/en-gb/
https://help.twitter.com/en/using-twitter/how-to-use-tweetdeck
https://help.twitter.com/en/using-twitter/media-studio
https://support.google.com/websearch/answer/4815696?hl=en
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Devices
It is important to consider which devices your audience will use to listen and engage 
with your podcast. If you expect most of your audience to view content on their mobile, 
make sure visuals are kept simple and limit the number of words used in content 
across all platforms. Research preferred devices for your target audiences and again, 
see what types of content your competitors are posting to get some ideas.

Networks for promotion
In order to boost the visibility of your podcast, seek promotional support from a 
range of networks and contacts. The best place to start is with your guests! They can 
promote the podcast through their employer, or other networks they are a part of. Ask 
them about supporting promotion in your follow-up emails and be sure to send them 
branded content for social media platforms.

You could also each out to groups or organisations who specialise in your episode 
theme or the work of your guests, including those based across King’s.

Reviewing and adapting your strategy
The best laid schemes o’mice an’ men, well, sometimes they just don’t work! Gathering 
listeners can be a slow and frustrating process, which requires lots of patience and 
creativity. Your marketing strategy will most likely need adapting as episodes are 
released, and your audience grows. Here are some helpful things to consider:

• Mix up content: Use a wide range of audio, visual and written content

• Utilise in-platform analytics: Keep an eye on content which receives the most 
engagement via the free analytics with your chosen platform.

• Schedule content: Revisit your scheduling platform data to identify the most 
popular times for engagement with your content. Mix up your posting schedule and 
see if that helps to boost listens..

• Review episodes: if some topics are more successful than others, you may want to 
adapt your episode schedule to create links between, or even diversify, content.

Make sure you schedule in time with your team to review MarComms engagement 
alongside listener data from your hosting platforms, so that such changes can be 
discussed, planned and signed off together.
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Section 7: Going Live
Tools and Resources

N: Platform checklist

Boilerplate written

Platform selected

Trailer uploaded

Aggregator accounts set up

King’s profile page / Website set up and player embedded

Space for additional content created

Link app account created 

O: Visual identity checklist

Logo

Colour palette

Cover art

Platform art

Episode covers (if using)
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P: Marketing checklist

Accounts decided and set-up

Quote card templates made

Trailer and clip template made

Infographics template made

Internal and external networks mapped and contacted

Analytics programmes set-up

Scheduling programmes set-up
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A successful podcast is of course one with lots of listeners! However, an engaging 
podcast about research will also have its own definitions of success. 

Meeting your objectives
The most obvious way of determining 
if your podcast has been a success is 
whether you have met your objectives. 
This is why it’s important that these 
are SMART, and that you are able to log 
evidence which demonstrates how you 
have achieved them. 

Remember that your objectives will likely 
change over time, so you may want to set milestones to assess progress throughout 
the project. For example, if you want to achieve 5000 listens over six months, but you 
only get 100 in month one, you may need to review how realistic the objective is, and 
how many listens you need to gain each month to meet it. This can inform content of 
future episodes, as well as your marketing and communication strategy.

Section 8: Evaluating success

For the Our Sick Society podcast, a mid-way review was 
built into the project plan. Halfway through our scheduled 
episodes, the team came together to discuss the process 
to date, successes and challenges, and progress in 
meeting objectives. It was a really helpful exercise and 
helped us to review future episodes and stay on-track.

Research impact
A good podcast can support research impact – which is becoming increasingly 
important for higher education institutions to evidence. 

Each university is required to participate in a national research assessment exercise 
called the Research Excellence Framework (REF), which ultimately determines how 
much funding is received from the government.

https://internal.kcl.ac.uk/innovation/strategypolicy/REF-2021/impact/REF-Impact-Guidance
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Not only does the REF act as a helpful benchmarking tool, but it also helps us to 
provide evidenced accountability for public spending on research. 

For the purposes of the REF, impact is defined as “an effect on, change or benefit to 
the economy, society, culture, public policy or services, health, the environment or 
quality of life, beyond academia”.

In addition to the REF, there is also the Knowledge Exchange Framework (KEF) 
assessment, which measures the extent to which knowledge produced from research 
can be used for the benefit of the economy and society. This is a relatively new 
assessment but is a process which is being prioritised by King’s alongside the REF, so 
it’s good to get your head around these processes as early as you can!

The impact of research is usually assessed by its Reach and its Significance, and so 
effective public engagement and marketing of a podcast can be critical in boosting 
visibility of our work and achievements. It can also strengthen partner relationships, 
and facilitate discussion for future collaboration.

Your podcast can directly contribute to increasing the impact of a particular piece of 
research, particularly when you invite researchers to lead their own episodes, as well 
as being a successful project in its own right. Perhaps it could even form part of a 
future REF Impact Case Study! 

Speak to your REF support representative for more information.

Strengthening your skills
The ESRC Centre for Society and Mental Health believes that research should not take 
place in a vacuum, and that effective, relevant and impactful research can only be 
developed through direct participation and co-production with non-academic contacts 
and those who have lived experience of issues being explored. Public engagement 
activities such as podcasting or social media engagement can be an important step 
in building awareness of such research and related engagement or collaboration 
opportunities, but relies on skills not traditionally prioritised in academia.

Academics are increasingly required to be savvy communicators, and to engage a wide 
range of audiences with their work (as we have seen with the increasing emphasis 
on the REF and KEF). By participating in a podcast, you are learning how to talk about 
your research in a different way, how to tie your research to current affairs, and how 
to demonstrate why your research can influences peoples’ lives. You will also develop 
networking, presentation and facilitation skills. Success is not just for the podcast but 

https://kef.ac.uk/about
https://www.fasttrackimpact.com/ref-tips#:~:text=Impact%20is%20made%20up%20of,it%20has%20reach%20as%20well.
https://impact.ref.ac.uk/casestudies/
https://internal.kcl.ac.uk/artshums/staff/research/ref/refimpact
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can also be measured by the skills developed by the wider team! Make sure you bring 
the team together to review and discuss personal objectives, expectations, challenges 
and achievements throughout and at the end of the project.

External review
It may be helpful to ask someone outside of the project team to review your progress. 
This can happen at the beginning, middle or end of your podcast project, and is a useful 
way of identifying pitfalls or opportunities which you may have missed. An external 
review can assess whether or not:

• Episodes are addressing your theme

• Objectives are effectively measuring the success of your podcast

• You are engaging appropriate networks for involvement and support

• You are communicating appropriate key messages about the podcast and King’s 
more broadly

The review can be carried out by someone your department, by another King’s podcast 
team, or perhaps a member of the KERN. 

Capturing lessons learned
Finally, throughout your project, you may learn some important lessons about what 
works and what doesn’t, which can be really useful for both your team and other 
podcasters across King’s. 

For your team, schedule regular meetings between episodes to discuss how things 
are going, and to see if any revisions to your project or marketing plans are required. 
It is also helpful to capture 
these lessons more formally, 
either via a written report, an 
evaluation meeting or…  
a toolkit! 

Good luck with your podcast!
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The Our Sick Society Team
This guide was developed by:

• Verity Buckley - Project lead

• Dr Sally Marlow - Principal Investigator

• Buddy Peace - Producer

• Nicol Bergou - Producer of the PhDeets podcast

With support from the wider project team:

• Dr Charlotte Woodhead - Episode lead

• Dr Gemma Knowles - Episode lead

• Lavinia Black - Episode lead

• Katie Lowis - Production Support

Feedback
We hope you found this guide and the wider toolkit useful! If you would like to provide 
feedback or make content suggestions, please email csmh@kcl.ac.uk. 

Further support
Email csmh@kcl.ac.uk to join the King’s Podcast Producers Teams group.

Contact kern@kcl.ac.uk for more information about the King’s Engaged Researcher 
Network.

Visit the KERN website for other channels of support available across King’s

More in the series 

• Developing a guest podcast episode

• Being interviewed for a podcast

https://www.kcl.ac.uk/people/verity-buckley
https://www.kcl.ac.uk/people/sally-marlow
https://buddypeace.com/
https://phdeets.buzzsprout.com/
https://www.kcl.ac.uk/people/charlotte-woodhead
https://www.kcl.ac.uk/people/gemma-knowles
https://www.kcl.ac.uk/people/katie-lowis
mailto:csmh%40kcl.ac.uk?subject=
mailto:csmh%40kcl.ac.uk?subject=
mailto:kern%40kcl.ac.uk?subject=
https://kingsengagedresearchblog.wordpress.com/contact/
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ESRC Centre 
for Society and  
Mental Health

44-46 Aldwych
London

WC2B 4LL
www.kcl.ac.uk/csmh

csmh@kcl.ac.uk
@kcsamh


